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1 Getting started

Printing this guide
Change the paper size to print this document on any printer.

1. Open the PDF file in Adobe® Acrobat®.
2. From the File menu, select Print.

The Print dialog box appears.

3. Select the desired paper size, for example, A4 or letter.
4. In the Page Scaling list, select Fit To Printable Area or

Shrink To Printable Area.

Note: The names in the Page Scaling list vary according to the version of
the Adobe Acrobat software.

5. Click OK.
This document is printed to the selected paper size to your printer.



System overview
The Xerox CX Print Server, Powered by Creo®, for the Xerox®
DocuColor® 7002/8002 Digital Press is an on-demand prepress
system that uses advanced prepress technologies to drive the
Xerox DocuColor 7002/8002 Digital Press.

The CX print server enables you to print from computers running
the Microsoft® Windows® operating system and Apple® Mac OS®

operating system software. Using raster image processor (RIP)
technology, the CX print server converts image files in page-
description language (PDL) formats—for example, Adobe
PostScript®, PDF, and variable data printing formats—to a suitable
ready-to-print (RTP) format for direct high-quality digital printing.
The CX print server also streamlines the printing process by
allowing you to print with preset workflows.

In combination with the printer, the CX print server enables you to
efficiently print flyers, brochures, pamphlets, dummy catalogs, short-
run trials, and print-on-demand publications. When installed as a
network printer with the CX print server, the press prints at the full-
rated speed.

The CX print server combines RIP functionalities, automation,
control tools, and special hardware development capabilities with
Windows-based architecture.

Hardware and software components

The CX print server includes:

● Creo hardware, including the interface board
● Off-the-shelf hardware
● A DVD-RW drive with DVD burning software
● The following software:

❐ CX print server software
❐ Adobe Acrobat 9.0 and PDF 1.8 (PDF library 9.0)
❐ Enfocus PitStop Edit
❐ Microsoft Internet Explorer® 6

Supported formats

The CX print server supports the following file formats:
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● PostScript (composite or pre-separated files) (levels 1, 2, and 3)
● Adobe PDF (versions 1.2 through 1.7)
● EPS
● Creo VPS (Variable Print Specification)
● Xerox VIPP® (Variable Data Intelligent PostScript PrintWare)
● VIPP.VPC (VIPP Project Container)
● PPML (Personalized Print Markup Language)
● PPML.zip
● File formats from various prepress systems—for example,

Kodak® Brisque® and TIFF/IT software
● CT, LW
● JPEG
● TIFF
● Pre-separated formats

Overview of the Workspace

When you start the CX print server software the workspace
automatically appears.

The workspace contains different areas that enable you to monitor
your job during the process and print stages. In addition, the
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workspace includes tools and options that enable you to fully
customize and manage your server and jobs.

Workspace area Description

Toolbar

Consists of shortcut buttons for the Import window , Resource

Center , Calibration , Spot Color Editor , Gradation ,

Imposition Template Builder , and Alerts 

Printer Status panel The Printer Status pane displays information about the current printer
status—for example, Printing, Ready, Warming up.

The printer icon changes according to the configuration of the printer
and the finishing devices connected.

Resource details Click Trays, Finishers, Toners, or Server to display information about
the size and type of paper in each tray, the connected finishing devices,
the available toner, and disk space and network details.

Under Server, you can also view the date that the printer was most
recently calibrated. Progress bars display information about incoming
and outgoing jobs.

.

If there is a problem with one of the printer components or with the
server, a red indicator appears in the printer icon and next to the
relevant component—for example, if a tray is empty.
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Workspace area Description

Process and Print queues Consists of the Process Queue, which lists the files to be processed.
After a file has been processed successfully, it moves either to the Print
Queue (the upper area) or to the Storage area.

 Indicates that the queue is ready for processing or printing.

 Indicates that the queue is suspended. You will need to release
the queue in order to process and print the jobs in this queue.

Note: When a queue is suspended you can open and edit the job
parameters of a job.

Storage area The Storage area contains files that:

● were successfully printed
● were held, were aborted, or failed during processing or printing
● were sent directly from the client workstation to the Storage area or

were imported to the Storage area.

There are three different views available in the Storage area: List,
Preview, and Gallery.

You can modify the columns and information that is displayed in the
Storage area.
To add or remove a column, right-click on the Storage area title bar and
select the column that you want to add or remove.

Note: If you select Copies, then you will be able to change the number
of copies for that job and submit it for printing without opening and
editing the job parameters.

Turning on the CX print server
1. Turn on the monitor.
2. Open the front panel of the CX print server, and push the

power control button.

The power indicator on the front panel lights up, and the
Windows operating system logon screen appears.

The CX print server splash screen appears, followed by the
workspace.
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Notes: If the workspace does not automatically appear, open the application
from the Windows Start menu. By default, you can open the workspace
without logging on each time. If you want each user to log on, clear the Auto
Log On checkbox in the Preferences window, and then assign each user an
access level and password.

There are three different access levels available:

● Operator (default): Enables the user to operate the CX print server and
configure the Preferences.

● Administrator: Enables the user to access all features and settings on the
CX print server

● Guest: Enables the user to import a job through an existing virtual printer
and view the workspace

Note: By default the Windows screen saver is off. If the screen saver is
activated with a password, then the user name is set to operator and
password is spire.

Turning off the CX print server
Requirements:

If you are working in the IPDS workflow mode, you can not shut
down the software until the IPDS connection is disconnected.

1. From the File menu in the workspace, select Exit.
A confirmation message appears.

2. Click Yes.
The CX print server software closes. This may take a few
minutes.

Note: If you move the cursor over the server icon on the taskbar, the
following tooltip appears: Color Server is Shutting Down. Please Wait.

3. Verify that the CX print server icon does not appear on the
taskbar.

4. From the Windows Start menu, select Shut Down, and click
OK.

5. After the CX print server has shutdown, you can now turn off
the the printer
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2 Setting up your
computer for printing

Setting up your computer overview
Printing Methods

Some methods for printing with the CX print server:
● Submit the job to one of the CX print server virtual printers. The

job is spooled and then processed or printed (according to the
selected job flow of the virtual printer). If you use this method,
you can print from any software—for example, Microsoft Word—
and use any file format from any Windows and Apple Mac®.

● Drag the job to a hot folder. The job is spooled and processed or
printed (according to the selected job flow of the corresponding
virtual printer). If you use the hot folder method, you can print
most PDL files—for example, PostScript, PDF, EPS, Variable
Print Specification, and PPML.

Network printers

To print your file using a CX print server virtual printer, you first
need install the virtual printer as a network printer on your computer.

After you install a network printer on your computer, you will be
able to submit files for printing. The network printers are installed
by default with the Print Driver software. You can change the
default settings of the network printer to use the PPD parameters
instead of the Print Driver software.

The CX print server supports printing from the following operating
systems:
● Mac OS X
● Windows 2000, Windows XP, Microsoft Windows Vista®,

Microsoft Windows Server® 2003, and Windows Server 2008

The CX print server provides default network printers, referred to
here as virtual printers.

A virtual printer contains preset workflows that are automatically
applied to all print jobs processed with that virtual printer. The
default virtual printers are published on the network with specific
parameters set for processing and printing.



The default virtual printers are:

● ProcessStore

Files sent to this printer are automatically processed and stored
in ready-to-print (RTP) format in the Storage area. Later, you
can submit an RTP job for printing, or change the parameters of
the job and resubmit it for processing or printing.

● ProcessPrint

Files sent to this printer are automatically processed and
immediately sent to the press for printing.

● SpoolStore

Files sent to this printer are spooled to the Storage area and
wait until you submit them for processing and printing. The files
remain in PDL format (such as PS, PDF, VIPP, VPS, and PPML).

Print Driver software

Use the Print Driver software to set job parameters when you are
submitting a job to the CX print server from any application in your
computer. The Print Driver software is automatically installed on a
Windows computer when you set up a network printer.

Note: On a Mac computer, you must install the Print Driver software manually.

In the Print Driver window, you can perform the following actions:

● Define or change job parameters regardless of whether your
computer is connected to the server

● Lock a job
● Save a set of parameters. Sets are useful when you want to

print different jobs with the same parameters, or if you want to
reprint a job.

● Retrieve a saved set of parameters
● Check the status of the printer
● Define PostScript parameters for the job
● Preview imposition layout
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Setting up printing on a Windows computer

Adding a network printer to your Windows computer
To print from a Windows computer, you first need to add a CX print
server virtual printer to your client workstation.

Tip: Following are some shortcut tips for setting up a printer. The full
procedure is detailed below.

● Locate the CX print server in My Network Places, and then double-click
on the network printer you want to install. The network printer is
automatically installed on your computer and appears in the list of printers.

● If you know the name of your CX print server, click Start > Run, and then
type \\server name. The CX print server opens showing a list of all the
network printers. Double-click on the network printer you want to install.

1. From the Start menu, select Settings  > Printers and Faxes.
The Printers and Faxes window appears.

2. In the Printer Tasks area, select Add a printer.
Note: Your computer might have slightly different wording from what
appears in this task.

The Add Printer Wizard appears.
3. Select Next.
4. Select A network printer, or a printer attached to another

computer, and then click Next.
5. Select Browse for a printer, and click Next.
6. Find the CX print server, and double-click it to display the list

of network printers.
7. Select the desired printer, and click Next.
8. When a message appears, click Yes.
9. Select one of the following:

● Yes if you want to set this printer as the default printer on
your computer.

● No if you don't want to set the printer as the default printer
on your computer.

10. Click Next.
11. Click Finish to close the wizard.

The CX print server network printer is added to your printer list. In
addition, the Print Driver software and PPD file are automatically
installed.
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Loading the Print Driver software for the first time
Requirements: 

A network printer must be defined on your computer.

Load the Print Driver software after installing a network printer so
that the CX print server will be ready for printing.

1. Open a file with its corresponding application—for example,
open a PDF file in Adobe Acrobat.

2. From the File menu, select Print.
The Print dialog box appears.

3. Select one of the network printers—for example, Print and
click Properties.

A message tells you that the software is loading.

Note: This process may take a few minutes.

After the software loads successfully, click Finish. The job
parameters window appears.

4. Close the job parameters window and printer Print Dialog box
to complete the installation of the Print Driver.

The network printer is set up for printing using the Print Driver
software.

Deactivating the Print Driver software
Deactivate the Print Driver software if you want to access the PPD
file parameters. The Print Driver software is active by default.

1. From the Windows Start menu, select  Settings > Printers
and Faxes.

2. Right-click the printer icon of the network printer you want to
deactivate the Print Driver, and select Properties.

3. Click the Print Driver tab.
4. In the Enable enhanced user interface, list select off.
5. Click Apply.
6. Click OK.
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Removing the Print Driver software
Perform this procedure if you need to upgrade to a later version of
the Print Driver software or if you want to install the Print Driver
software for a printer with a different name.

Requirements: 

All applications must be closed.

1. From the Windows Start menu, select  Settings  > Printers
and Faxes.

2. Right-click the network printer that you want to remove, and
select Delete.

3. In the Printers and Faxes window, from the File menu, select
Server Properties.

4. In the Print Server Properties dialog box, click the Drivers tab.
5. Select the appropriate printer, and click Remove.

The driver is removed.
6. From the Windows Start menu, select Run.
7. In the Open box, type \\, followed by the host name or IP

address of the server, and click OK.
The server window opens.

8. Navigate to \Utilities\PC Utilities\Driver Extension.
9. Perform one of the following steps:

● If you are using Windows XP, double-click
DEX_Uninstaller.exe

● If you are using Windows Vista, right-click
DEX_Uninstaller.exe, and select Run as Administrator.

The Print Driver software is removed.

Downloading fonts
Use the HF_Fontdownloader hot folder, located in D:
\HotFolders, to install new or missing fonts to the CX print server
fonts directory.

The HF_Fontdownloader hot folder can be used with the
following operating systems:

● Windows Vista
● Windows XP
● Windows 2000
● Windows Server 2008
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● Windows Server 2003
● Mac OS X

Drag the required fonts from the computer to the
HF_Fontdownloader hot folder.

Setting up printing in Mac OS

Installing the Print Driver software in Mac OS

During the installation of the Print Driver software, the PPD file is
automatically copied to your computer. In versions earlier than
Mac OS 10.4, you must copy the PPD manually.

1. From the Go menu, select Connect to Server.
2. In the Server Address box, type your server address, and

click Connect.
3. In the Connect as area, select Guest.
4. Click Connect.
5. Select Utilities and click OK.
6. Select the Mac Utilities folder.
7. Double-click the

CX8002_ColorServerPrintDriverInstaller.dmg file.
The Welcome screen appears.

8. Click Continue.
9. In the message window, click Continue.
10. In the Software License Agreement window, click Continue.
11. Click Agree to agree to the terms and continue with the

installation procedure.
12. Click Change Install Location.
13. In the Select Destination area, select the destination volume

in which you want to install the Print Driver software, and click
Continue.

14. Click Install.
15. Type your login name (if necessary) and password, and click

OK.
16. Click Close.

The Print Driver software and PPD are installed.
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Note: If you deactivate the Print Driver software, you can still use the PPD
because it has been installed already.

Defining a printer with the Print Driver software in Mac OS
Requirements: 

The following information must be available:

● IP address and computer name of your CX print server

● Name of the network printer that you want to use with the Print
Driver software

1. On your Mac computer, open the System Preferences window
and double-click Print & Fax.

2. In the Print & Fax window, click the add (+) button.

Note: You can also define your printer using the Default option.

3. In the Add Printer window, select the IP tab, and enter the
following information:

● In the Address box, type the address of your server.

● In the Queue box, type the name of the network printer that
you want to use with the Print Driver software.

● In the Name box, type a name for the printer.

● In the Print Using list, select Other.
4. Navigate to Library / Printers / PPDS / Contents /

Resources / en.lproj, select either Europe_A4 or US_Letter,
and then select the CX8002v1.PPD.

5. Click Open.
6. Click Add.
7. Close the Print & Fax window.

The network printer is defined with the PPD file.
8. In the Print & Fax window, double-click the network printer.
9. Click Utility.
10. In the Enable Enhanced User Interface list, make sure that

On is selected.
11. In the Server Hostname box, type the IP address of the server.
12. Click Apply.
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Removing the Print Driver software
Perform this procedure if you need to upgrade to a later software
version of the Print Driver software.

Requirements: 

All applications must be closed.

1. Open the System Preferences window, and double-click Print
& Fax.

2. In the Print & Fax window, select the network printer that you
want to remove.

3. Click delete (-), and then click OK.
4. Navigate to Library / Printers / Creo_Color_Server_Tools,

and delete the Creo_Color_Server_Tools folder.
5. Navigate to Library / Receipts folder, and delete all of the

CX*.pkg files.

The Print Driver software is removed. You can now upgrade the
Print Driver software.

Note: You will need to reinstall the network printers that you removed after
you have upgraded the software.
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3 Calibration

Calibration overview
Obtaining the most satisfactory print quality on your printer
depends on a number of issues. One of the most important issues
is steady toner density. Toner density is affected by many factors
such as heat, humidity, and service settings. Toner density also
tends to vary over time. Such variations cannot be totally
eliminated, but you can perform the calibration process to
compensate for them.

The calibration process consists of creating calibration tables that
are mapped to a specific media type, paper weight, and screening
method.

You can create calibration curves using either of the following
options:

● Inline spectrophotometer: Enables you to automatically calibrate
and create profiles for your digital press. The automatic
calibration tool allows you to create calibration curves for
several screening types.

● Calibration wizard: The Calibration wizard guides you through
printing a color chart, scanning the streams of color patches in
the color chart, and creating a calibration table based on the
scanned measurements.

The CX print server uses the data in this table to compensate for
the differences between the the actual, measured density level,
and the target level, the target density.

You should create calibration tables in the following instances:

● When you use a new paper stock
● When prints show “color casts”
● After machine maintenance or hardware changes
● If there are drastic ambient changes (temperature and humidity)
● Every 24 hours, to compensate for potential variations in toner

density



Defining the inline spectrophotometer as the
calibration device

By default, the Inline Spectrophotometer is the selected
calibration device on the CX print server. If the X-Rite i1®

spectrophotometer is connected to your CX Print Server, you can
switch to the Inline Spectrophotometer in the Preferences window.

1. From the Tools menu, select Settings.
2. Under Administration, click Calibration Device.
3. Select the Calibration is done using Inline

Spectrophotometer option.

4. Click Save.

The inline spectrophotometer is defined as the default
measurement device for creating calibration tables and destination
profiles.
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Creating a calibration table using the Inline
Spectrophotometer

Requirements:

The media that you choose must be loaded as SEF, and the
printer must be ready for printing.

1. Suspend the Process Queue.
2. Make sure that the Print Queue is released and that no jobs

are running.
3. From the Tools menu, select Calibration.

4. Define the parameters as follows:
a. In the Paper Coating list, select either Coated or

Uncoated for the paper type.

Note: You can only select the media that is loaded in the printer.
b. In the Weight list, select the weight of the paper stock.
c. In the Tray list, select the tray where the paper stock is

loaded for the calibration.
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d. In the Screening area, select the screening method for
which you want to create a calibration table.

Note: You can select all screening methods. The server creates a
calibration table for each screening method that you select.
e. The Save as box displays an automatic name for the

calibration tables according to the media name. If required,
you can type a different name. The screening number is
appended to the resulting calibration file name.

5. Click Calibrate.

During the calibration process, a progress bar appears at the
bottom of the Calibration Tool window. The progress bar
indicates the calibration stages: printing the chart, measuring
it, and saving the measurements.

When the calibration process is completed, a check mark 
appears next to the selected screening methods.

6. Click Close, when the calibration is completed and after all
green check marks appear.

The new calibration table (or tables) is added to the list of
calibration tables in the Calibrations window and the Media and
Color Manager in the Resource Center.

To apply one of these calibration tables to your job, open the job
parameters window, and select Color > Calibration. Select from
the list the calibration table you want to apply to your job, and then
submit the job for printing.

Creating a calibration table using the X-Rite i1
spectrophotometer

Requirements:

● Your spectrophotometer must be connected to the USB port on
the CX print server.

● Install the driver when prompted for the first time connecting the
device. Refer to the spectrophotometer product documentation
for more details.

● Make sure that your spectrophotometer is calibrated by placing
the spectrophotometer on its plate.

● Make sure that the Print Queue is not suspended and is ready
for printing.

● Make sure the X-rite i1 spectrophotometer is selected in the
Preferences window.
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1. From the Tools menu, select Calibration.

2. In the Number of copies box, type the number of copies you
want to print.

3. Click Print.
The calibration chart prints.
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4. Step 2 of the Color Calibration Wizard appears. Follow the
instructions in the wizard to complete the calibration.

5. After each color sweep, wait for the check mark to appear next
to the appropriate icon and follow the instructions as listed.

Note: Make sure that the separation columns on the chart are scanned in
the order they appear in the icons: Cyan > Magenta > Yellow > Black.

When all of the separation columns have been successfully
scanned, a check mark appears next to all icons.

20 Chapter 3—Calibration



Notes:

● If at any stage the scanning has not been completed properly, click
Reset and scan again.

● If an error occurs while you are scanning the chart, an alert message
appears. Click OK and re-scan the charts.

6. To save the calibration table, do one of the following:

● Select As default name to automatically name the
calibration table using the screening method, meda type,
and date.

● Select Save as to type your own name.

Note: It is strongly recommended that you include the media type, weight,
and screening method in the calibration table file name.

7. Click Finish.

Mapping jobs to calibration tables
When you create a calibration table, the calibration table is based
on the media type, paper weight, and screening method that you
selected during the calibration process. Any job that has the
specific media type, paper weight, and screening method that you
selected, will automatically be mapped or linked to this calibration
table.

In the Job Parameters window, under Color > Calibration, the
Linked option is selected by default.

When you send your job to print, because the calibration table is
linked to the job, it is automatically used when the job is printed.

See also:
Mapping media using the Media and Color Manager
tool on page 52
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4 Printing a file in
Windows and Mac OS

Printing a file to the CX print server
Requirements: 

A network printer must be defined on your Windows and Mac
computer.

This task describes how to print from a Windows computer, and
can also be followed for printing from a Mac.

1. Open a file with its corresponding application—for example,
open a PDF file in Adobe Acrobat.

2. From the File menu, select Print.
3. In the Name list, select the desired network printer—for

example, <servername>_Print.
4. (Optional) To modify job parameters, perform the following steps:

a. Click Properties.
b. Modify the parameters.
c. Click OK.

5. Click OK.
6. In the Print dialog box, click OK.

The file is sent to the CX print server where it is processed and
printed.

Using a hot folder to print
Use hot folders to automate your workflow and to save time by
simultaneously submitting multiple files for printing.

You can use hot folders to process and print files from any
computer. The following procedure can also be followed on a Mac
computer.

1. On your Windows desktop, double-click the My Network
Places icon.
In Mac OS, from the Finder menu, select GoConnect to
Server.



2. Locate the CX print server, and double-click it.
A list of all the shared folders, hot folders, and printers appears.

3. Double-click the desired hot folder—for example,
HF_ProcessPrint.

Tip: You can drag the hot folder icon to your desktop to create a shortcut to
the hot folder for future use.

4. Drag the desired files to the hot folder.

All the files are processed and printed automatically, according to
the hot folder workflow.

Password protect jobs
The CX print server enables you to protect sensitive data and
control its printing. You can lock and password protect a job on
your computer and submit it for printing on the CX print server.

Requirements: 

● A CX print server network printer must exist on your client
workstation.

● The printer status on the CX print server must be in Ready mode.

Using the Print Driver software, you can apply a password to a job
that was created in any application. Whoever prints or reprints the
job must use the password to unlock it and release it for printing.

1. On your computer, open a file—for example, a PDF file.
2. From the File menu, select Print.
3. In the Print dialog box, in the Name list, select the name of the

network printer that you want to submit your file to.
4. Click the Properties button.

The Print Driver window appears.
5. In the Print Driver window, click the Lock button .

The Secure Printing dialog box appears.
6. In the Password box, type a password consisting of four

numeric characters—for example, 9999.

Note: The password must consist of exactly four numeric characters.

7. Click OK.

The job is password-protected, and nobody can print it without
using the password.

8. In the Print Driver window, click OK.
The password-protected job is submitted to the network printer
where it is sent to the CX print server for processing and printing.
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9. In the Print Queue area, right-click the password-protected job
that you want to print, and select Release to print.
The Secure Printing dialog box appears.

10. In the Password box, type the password that was defined for
this job.

11. Click OK.
Your job is unlocked and printed. When the printing is finished,
the job is automatically deleted.

See also:
Secure printing overview on page 38
The Preferences window on page 123
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5 Printing from the color
server

Importing and printing a job

You can import a job:

● When a page-description language (PDL) file—for example,
PDF or PostScript—is created on a computer that is not
connected to the CX print server

● When a PDL file is located on a folder on the network, or on
external media, such as a CD-ROM

● When the desired file resides locally on the CX print server

1. From the File menu, select Import.
2. To access the desired files, click the up one level button, or

double-click on the file folders to go down the file tree.
3. In the upper list in the Import window, select the desired file(s)

and click the add button.

Note: Use SHIFT or CTRL to select several files or CTRL+A to select all the
files. If desired, add the same file more than once.

The file(s) appears in the lower list.
4. Select a printer from the Virtual printer list.

Note: To remove a file, select the desired file in the lower list in the Import
Job window and click the remove button.

5. Click Import.
All files currently listed on the lower list are sent to the CX print
server to be processed and printed as defined in the selected
virtual printer.

6. If your job is moved to the Storage area, submit the job for
printing.

Previewing and editing a PDF file
In the Storage area, right-click the PDF file that you want to
preview or edit, and select Job Preview & Editor.
The file opens in Adobe Acrobat.



Editing a job overview
You can preview and edit any PDL and RTP job that is in Storage
Area. PDL files are opened in Adobe Acrobat software, and RTP
files are opened in the Job Preview & Editor  tool.

In Adobe Acrobat, you can view and edit the PDL job as you would
normally. In addition, this version of Adobe Acrobat includes the
Pitstop plugin that includes more editing tools. For more
information, refer to the documentation included in the Pitstop and
Acrobat software.

In the Job Preview & Editor  window you can view thumbnails of
the job while you navigate to the various pages of a job. For an
imposed job, you can view the imposed sheets, including the
layout of the pages on each sheet. You can also view the pages'
orientation, crop marks, and fold marks.

Jobs that you edit in the Job Preview & Editor window cannot be re-
RIPed. After a job is saved in the Job Preview & Editor window, it
is a new RTP file without an associated PDL file. You cannot apply
parameters that require re-RIPing to such jobs.
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Moving a page in a job
Move a page in an RTP job to a new location within the job.

When you move a page, the page numbers are updated accordingly.

1. In the Job Preview & Editor window, click the Thumbnails tab.
2. In the Thumbnail pane, click the page that you want to move.
3. Drag the page to the target location.

Note: The red marker indicates where the page will be inserted.

4. Click Save As to save the changes in the job.

Next:
Note: This feature can be used for the Xerox eBind solution to print the last
page of the job first (Nth page), then 1 to N-1.

Deleting a page from a job
1. In the Job Preview & Editor window, click the page that you

want to delete, and click Remove.
The page is deleted and the page numbers are updated
accordingly.

2. Click Save As to save the changes.

Merging one or more pages into a job
Merge one page, multiple pages, or all pages from one job into
another.

Requirements:

The RTP job that includes the page you want to copy must have
the same page size and orientation as the job that you are editing.

1. In the Job Preview & Editor window, click the Thumbnails tab.
2. In the left pane of the Thumbnails tab, determine a location

for the merged page. Click the page preceding this location.

A yellow outline appears around the selected page.
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3. Click Merge Jobs.

Note: Only those RTP jobs that have the same page size and orientation as
the job that you are editing appear in the list.

4. Select the job with the page that you want to merge and click
OK.
The job opens in a separate window.

5. Do one of the following:

● To merge one page, select the page that you want to merge
and click Merge.

Note: You can also drag the page from the job window to the desired
location in the left pane of the Thumbnails tab.

If you want to merge more than one page, repeat this step until all
desired pages are merged. You can also select different locations for the
merged pages in the Job Preview & Editor window.
● To merge all pages into the job, click Merge All.

The merged pages are inserted into the desired location, and
the page numbers are updated accordingly.

6. Click Close to close the job window.
7. Click Save As to save the changes.

Replacing pages
In certain cases you may have a large job and you need to replace
one of the pages. In this case you can create an RTP file of the
page which you need to replace and then using the Job Preview &
Editor you can replace this page.

Requirements:

The RTP job that includes the page you want to replace must have
the same page size and orientation as the job you are editing.

1. Import and process the new page in order to create a new
RTP file.

2. Open the original RTP job in the Job Preview & Editor.
3. Merge the new RTP file using the steps described in Merging

one or more pages into a job.
4. Delete the incorrect page using the steps described in Deleting

a page from a job.
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Finding the CMYK values of a specific area
Use the Show Color Values tool in the Job Preview & Editor
window to find out the CMYK values of a specific area on the page.

A processed job must be displayed in the Job Preview & Editor
window.

1. In the Job Preview & Editor window, click the Show Color
Values button.

2. Move the pointer to the location on the page where you want
to measure the color values and click.
The CMYK dot percentage values and spot color CMYK
equivalent values appear as a tool tip.

Verifying the content of the job
Use Preflight features to check your document before processing
or sending a job to print.

The following preflight features are available:

● PDF analyzer
● Preflight check
● Preflight report

PDF Analyzer

You can use the PDF analyzer to check imported PDF files for
problems that may affect processing. The PDF analyzer checks
the following elements:

● Document: identifies incompatibilities of Acrobat software with
compression, encryption, security, and other properties

● Pages: detects empty pages and identifies the page size,
annotations, and other properties

● Fonts: determines whether specific fonts are in the PDF file and
whether they are embedded

● Colors: detects color space information, spot colors, rendering
information, and color management settings

● Images: identifies image resolution, whether images are
skewed or flipped, and whether images are compressed
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● OPI: detects whether OPI is used. If so, the PDF analyzer
detects the OPI version and determines whether any high-
resolution images in the OPI path are missing

● Text and line art: identifies the size of text, the width of the
lines, white text, and objects and flatness tolerance

● PDF/X: determines whether the file conforms to PDF/X-1a and
whether the file contains PostScript fragments

Preflight Check

The Run preflight parameter enables you to check the status of
key job components before the job is sent for printing.

During the preflight check, your job is RIPed and the missing
components are identified. The preflight check detects the status
of the following key job components:

● High-resolution images or the wrong links to the high-resolution
images folder

● Missing fonts
● Spot colors that are not defined in the CX print server spot color

dictionary
● Dynamic exception commands for a file that was submitted via

a dynamic page exceptions virtual printer

Preflight Report

The preflight report is a job-related report that provides information
about the status (missing or found) of key job components prior to
printing and enables you to correct your files accordingly.

It is especially useful to run the preflight check before you print a
complex job with a large quantity of pages or copies. The preflight
check detects the missing job components and displays them in
the Preflight Report dialog box. You can review the report and
resolve the missing components and thus save processing time
without error or failed messages constantly appearing.

If you run a preflight check and all key components are found, the
job is processed and printed according to the job flow that you
selected. If the test fails (missing key elements are detected), the
job is returned to the Storage window with the preflight report
available for inspection.

The preflight report always reflects the last preflight run. If more
than one preflight check is run on a job, the latest preflight report
overrides the previous. When a preflight report is produced, the
date and time of the preflight check are indicated in the Job
History window.
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Note: Since the Preflight Report dialog box lists all key job components
(missing and found), you can use this report to view the existing (found) key
job components—for example, the list of the existing fonts in a job, and their
corresponding paths.

Analyzing a PDF job
You cannot use the PDF analyzer or perform a Preflight check on
PDF files that are locked or protected. If you do, a message will
appear stating that the file is encrypted.

1. In the Storage area, right-click the PDF file, and select PDF
Analyzer.

2. In the PDF PreFlight Settings area, do one of the following:

● To check the entire PDF file, select Complete Document.
● To check specific pages, select Pages, and enter the

desired page range.
3. If you do not want the report to automatically open when it is

generated, clear the Display report automatically check box.
4. If desired, change the report file name. By default, the report

file name consists of the original file name and the suffix _rep—
for example, if the file to be checked is sample.pdf, the report
file is named sample_rep.pdf.

5. If you want to save the report to a specific location, click
Browse and navigate to the desired location.

6. Click Run.

The PDF report is generated and opens automatically.
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Performing a preflight check
Check the status of key components before the job is sent for
printing.

You cannot use the PDF analyzer or perform a Preflight check on
PDF files that are locked or protected. If you do, a message will
appear stating that the file is encrypted.

1. Open the Job Parameters window of the job that you want to
perform a preflight check.

2. Select Services, and then select Preflight.

3. Select the Run preflight check box.
All four check boxes of the key job components are
automatically selected.

4. Clear any check box that you don't want to include in the
preflight check.

Note: If one of the selected job components is missing, the job status at the
end of the preflight check is failed, and the job is transferred to the Storage
window. Information about missing components appears in the Job History
window.

5. Click Submit.

The results of the preflight check are displayed in a Preflight report.
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Viewing and printing a preflight report
1. Right-click the job in the Storage area, and from the menu,

select Preflight report.
2. Click the desired report option to see the results for that option.
3. To print the report, click Print.
4. To save the preflight report, click Save and browse to the

desired location.

Note: If more than one preflight check is run on a job, the latest preflight
report overrides the previous one.

Preflight Report window
The Preflight Report window is opened by right-clicking your job
and selecting Preflight report.

Preflight options

HiRes Lists the missing and found high-resolution
images. If wrong links to the high-resolution
images folder exist, these are also listed.

Spot Colors Lists the missing spot color names (spot
colors that were not found in the spot color
dictionary), and the found spot color names
(spot colors that were found in the spot color
dictionary). The C, M, Y, and K columns
display the spot color CMYK equivalents.

If the status is Missing, the original CMYK
values that are embedded in the PS file are
used to emulate the desired spot color.

If the status is Found, the CMYK values that
are in the spot color dictionary are used.

Fonts Lists the name of missing fonts that are not
embedded in the file and do not exist in the
Font Library, and also fonts that are found.
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Preflight options

The Source column indicates whether the font
is embedded in the file or was found in the
Font Library.

Exceptions Lists the dynamic page exception commands
found in the file.

Indicators

 Missing Appears when key components in the job are
not found.

Not preflighted Appears if you did not select the preflight
option for the preflight check.

Found Appears when all of the files are found for the
selected option.

Show list

All Displays both missing and found options

Found Only Displays options that are found.

Missing Only Displays options that are missing.

Proofing the job using color sets
Select the most appropriate predefined color set to print your job
with the best color quality. The Color Set option includes four
predefined color sets. Each color set provides you with the best
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color and quality settings for a specific data type or a printed
product characteristic.

The color set options are as follows:

● Photos of people:

Provides the best color and quality settings for jobs such as a
family photo album

● Outdoor photos:

Provides the best color and quality settings for jobs that include
mainly photos of landscapes

● Corporate documents:

Provides the best color and quality settings jobs that are mostly
office documents, such as presentation files, Web pages, and
files with charts and logos

● Commercial materials:

Provides the best color and quality settings for jobs that include
both graphics and photos, such as advertising materials

To select the most appropriate color set for your job using the
recommended workflow, you can print a copy of your job with each
color set, review the printed sample jobs, and select the best print.
Then, in the Job Parameters window, you need to assign the color
set that provided the best results. If you know the color set you
want to use, you can assign a color set to your job without first
printing and reviewing samples jobs.

Note: When you select a color set, some of the color and quality parameters
are disabled.

Assigning a color set to your job

After printing and reviewing the four sample files, you now need to
assign the most appropriate color set to your original job.

1. In the Storage area, double-click your job.
2. Under Print, select Color Set.
3. In the Set list, select one of the sets that achieved the best

printed color results, for example, Outdoor photos.

The job is assigned the color and quality parameters that are
predefined for the Outdoor photos set. The default color and
quality parameters that are configured for this job, are disabled.

4. To print your job, click Submit.
Collect the printouts and review the color quality.
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Secure printing overview
The CX print server enables you to protect sensitive data and
control its printing.

Following are some of the options available:

● The Disk Wipe utility enables you to work in a more secure
environment, by permanently removing data left by files that
you have deleted.

● Password Protect Jobs (set in the Print Driver software)
● Deletion policy (set in the Preferences window)

See also:
Password protect jobs on page 24
The Preferences window on page 123
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6 Managing jobs

Archival and retrieval of jobs
To keep enough disk space free, back up jobs and their related
files to an external server and then delete them from the Storage
area. You can retrieve archived jobs and files later for further use.

Archiving is a method of backing up and storing a job and enables
you to increase the available space on your disk. A cabinet file (a
compressed file) that contains all the files related to the archived
job is created at the selected location. The archived job retains its
current status (that is, completed, failed, held, or aborted) and is
archived with the information in its job parameters and its Job
History windows.

Note: The CX print server automatically archives large jobs to several cabinet
files.

When retrieved, the archived job retains the original job name, not
the name assigned when archived.

Archiving a job
Back up and store a job so that more disk space becomes available.

Requirements: 

A folder for storing the archived job.

1. In the Storage area, right-click the job that you want to archive
and select Archive.

2. Locate the desired folder, and then click Archive.
A cabinet file (a compressed file) that contains all the files
related to the archived job is created at the selected location.

3. Delete the job from the Storage area.

Next:

If you are archiving a VDP job, then you will need to archive the
cached elements separately.



Retrieving a job
Requirements: 

You can only retrieve jobs that have been archived.

Note: If you are retrieving a VDP job, then you need to restore the cached
elements first.

When you retrieve a job, the archived job retains the original job
name, and not the name assigned when archived. The files related
to the job (for example, PDL) are also retrieved and the cabinet file
is not deleted.

You can retrieve more than one job at a time.

1. From the File menu, select Retrieve from archive.
2. Find the archived job under its archive name, and select the

related cabinet file.
3. Click Add.

The selected job appears in the lower list.
4. Click Retrieve.

The selected job appears at the top of the list in the Storage
area.

5. In the Job History window, verify that the file has been
successfully retrieved.

Forwarding a job to another CX print server
Requirements:

You can forward a job only if it is in the Storage area, and to a CX
print server with the same version.

1. In the Storage area, right-click the job, and select Forward to
> Other .

2. In the Host name / IP Address box, type the name or IP
address of the server that you want to forward the job to.

3. Click Find.
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4. Select one of the following:

● Send to Storage: to send the job to the selected server’s
Storage area.

● Send to print: to send the job to the selected server’s Print
queue.

5. Click Send.

Duplicating jobs
Requirements: 

You can duplicate a job only if it is in the Storage area.

In the Storage area, right-click the job, and select Duplicate.

The selected file is duplicated and is given the name of the original
job followed by the suffix _dup.

Note: The RTP job is duplicated to PDL format.

Resubmitting a job
In the Storage area, right-click the job that you want to submit
again, and select Submit.
RTP jobs are submitted to the Print queue; all other jobs are
submitted to the Process queue.

Printing copies of a job
Re-print more copies of a job directly from the storage folder
without opening the job parameters.

1. Right-click the title bar in the Storage area.
2. Select Add  > Copies to add copies to the Copies column in

the Storage Area.
3. Select the job, and type in the Copies field the amount of

copies that you want to print.
4. Drag and drop the job to either the Process queue or Print queue.
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Job Reports

Accounting Viewer overview
The Accounting Viewer provides information about all of the jobs
that were printed successfully through the CX print server. The
report is in the form of a tab-delimited file and contains detailed
information about the printed job, for example, job size, processing
time, and number of pages. You can filter, sort, and print the
report. You can also export the report to a spreadsheet application
—for example, Microsoft Excel—where you can manipulate the
data. By default, all of the jobs that were handled during the past
90 days are listed.

You can access the Accounting Viewer from the Info menu.

The accounting report also includes pages that where printed as
black-and-white or color pages. The accounting report is based on
the job's original input and the parameters that are set in the Job
Parameters window. To ensure the correct billing for black and
white or grayscale jobs, perform the following actions:

● Print a job in black and white
● Print a job that contains gray RGB elements as black and white

or black only

Job Report overview
The Job Report window contains all of the information from the
Job Parameters window for a specific job. The Job Report window
presents the job parameters on a single sheet and may be printed
or exported as a text file.

To access the Job Report window, in the Storage area, right-click
the desired job, and select Job report. In the Job Report window,
you can print the report, or export it to a text file.

Ensuring proper billing
Accounting feature reports what was printed on black-and-white or
color pages.

The CX print server report is based on the job’s original input and
the parameters that are set in the Job Parameters window. To
ensure proper billing, you need to perform the following actions:
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● Print a job in black and white
● Print a job that contains grayscale RGB elements as black-and-

white or black only
● Print a job that contains grayscale CMYK elements as black only

Note: Grayscale TIFF and EPS images created in CMYK applications (such
as Adobe Photoshop® software) are counted correctly as B&W instead of
Color in both the CX print server and the Xerox DocuColor 7002/8002 Digital
Press billing meters.

Printing a job containing gray RGB elements as black
and white
Print a job that contains gray RGB elements as black- and-white or
black only.

1. In the CX print server, open the Job Parameters  window and
select Color > Ink Saving  > Print grays using black toner .

2. Click Submit.

Printing a job in black and white
When printing a job in black and white, discard all color information.

1. In the CX print server, open the Job Parameters  window and
select Color > Color Mode, and select Grayscale.

2. Click Yes to discard all color information.
3. Click OK.

Printing a job containing gray CMYK elements as black
and white
Print a job that contains gray CMYK elements as black- and-white
or black only.

1. In the CX print server, open the Job Parameters  window, and
select Color > Protected colors.

2. In the CMYK area, select Preserve black color.
3. Click Submit.

InSite jobs
If your site includes a Kodak InSite™ Prepress Portal system,
exporting your job as a Brisque job from the CX print server
enables you and your customers to use InSite to proof online with
geographically dispersed users simultaneously, append
annotations or comments, and approve or reject pages over the
World Wide Web using a standard browser.
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After the RTP job is created on the CX print server, you can export
it as a Brisque job from the Storage window. When the customer
logs on (using their unique username and password), they can see
the status of their jobs, view a thumbnail of all pages in each job,
and quickly identify which pages require further corrections. The
customer is able to measure color density, make annotated
comments, and approve pages.

The online proofing cycle is shortened and accurate, and
consequently, the need for reprints is reduced.

Exporting a job as an InSite job
Export as a Brisque job to proof online over the World Wide Web.

Requirements:

Your site should have an InSite Prepress Portal system.

You cannot export VDP jobs or RTP jobs that were originally VDP
jobs.

The CX print server creates a folder that includes an .assg file.

1. Select the job in the CX print server Storage area.
2. Right-click the job and from the menu, select Export as InSite

Job
3. Find the required folder, and click Save.

A Brisque job is created in the selected location.

You may now register the files on the InSite server and start the
approval cycle.

PDF2Go jobs
PDF2Go is a port through which you can export RTP and PDL
files, and convert them to a PDF file during export. The CX print
server is capable of exporting jobs that are standard PDF files,
both before and after processing. For an exported RTP job, the
PDF file includes the rasterized data of the job.

The operation converts the RTP information to raster files that can
be encapsulated in a PDF format. This process ensures that the
file can be processed and printed on any PDF printer.

Exporting to PDF enables you to send a copy of your job for
approval before printing.
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Exporting an RTP or PDL file as a PDF file

You can export any RTP or PDL file located in the storage folder to
PDF format.

1. Select the job in the CX print server Storage area.
2. Right-click the job and from the menu, select for RTP files

Export as PDF2Go or Export PDF for PDL files.

3. For RTP files, select Print Optimized or Screen Optimized,
and then click OK.

Note: Screen optimized format creates a low resolution version of the job.

4. Browse to the folder that you want to save the file, and click
Save.

The PDF file can be printed on any printer.
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7 Managing color

Color tools overview
The CX print server provides you with a number of tools and
options that enable you to adjust and improve the color quality in
your jobs.

The following tools are available:
● Profile Manager
● Spot Color Editor
● Gradation Tool
● Calibration table manager
● Media and Color Manager

Managing color and profiles
A profile is a file that describes how a particular device reproduces
color. It represents the colorimetric behavior of a given device for
known media and imaging parameters (such as substrate/paper
stock, resolution, and inks). Profiles are used to reproduce color
from one device’s color space to another device's color space in a
consistent manner. They provide the necessary information to
convert color data between device-dependent color spaces and
device-independent color spaces. You use profiles to color manage
your system.

Color management is a series of steps taken to ensure that colors
are accurate and repeatable when transferred from one device to
another. Color management helps us reproduce the color
conceived by a graphic artist or photographer as closely as
possible on a monitor, a proof, or a press sheet. Color
management enables accurate and repeatable color reproduction,
within each device’s color capability, throughout the entire workflow.

Before you can print a color document, the color data in it must be
converted to the gamut of the printer. Whether performed by the
CX print server or a host-based CMS, the process of converting
color data for a printer is the same: the CMS interprets RGB object
data according to a specified source profile and adjusts both RGB
and CMYK data according to a specified output profile, also called
a destination profile by some color management systems.



The source profile defines the RGB color space of the object’s
source: characteristics such as the white point, gamma, and type
of phosphors used. The output profile defines the gamut of an
output device, such as a printer. The Color Server (or host-based
Content Management System (CMS)) uses a deviceindependent
color space to translate between the source color space and the
color space of the output device.

The Profile Manager on the CX print server enables you to import
profiles which define the color space of your printer and are based
on the combinations of paper and toner that you are using. For
different media types, you need different destination profiles.

Creating a destination profile
Requirements: 

Make sure that the printer is calibrated.

The media that you choose must be loaded as SEF, and the
printer must be ready for printing.

The Profiling Tool enables you to create destination profiles that
are best suited for the Xerox DocuColor 7002/8002 Digital Press.
You can create custom destination profiles for each press and fine
tune the color outputs of the press, improve color matching
between presses, and improve color consistency over time.

Note: It is recommended that you create a destination profile for each paper
stock that you use.

1. Suspend the Process Queue.
2. Make sure that the Print Queue is released.
3. From the Tools menu, select Profiling Tool.

The Profiling Tool window appears.
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4. Define the parameters as follows:
a. In the Warm up Print box, it is recommended that you type

10, which is the default value.

Warm-up print settings defines the number of copies of a
file that is printed before the standard ECI chart is printed
and measured by the inline spectrophotometer on the press.

Because the performance of the press is best after several
pages have been printed, it is recommended that you print
at least 10 copies of the warm-up file.

b. In the Paper Coating list, select either Coated or
Uncoated for the paper type.

Note: You can only select the media that is loaded in the printer.
c. In the Weight list, select the weight of the paper stock.
d. In the Tray list, select the tray where the paper stock is

loaded for the calibration.
e. In the Screening area, select the screening method for

which you want to create a calibration table.

Note: You can select all screening methods. The server creates a
calibration table for each screening method that you select.
f. In the Profile Name box, the Profiling Tool automatically

names the profile according to the paper stock name. To
change the default name, you can type a new name. The
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screening number and GCR level are automatically added
to the profile name.

g. In the Save in area, leave the Profile Manager selected.
Your new profile will be saved and added to the list of
exisiting profiles in the Profile Manager in the Resource
Center.
If the Profile Manager already contains a profile with the
same name, the new profile overwrites the existing profile. If
you select Other, and the destination you select already
contains a profile with the same name, you are asked if you
want to overwrite the existing profile.

5. Click Create Profile.

During the profile creation process, a progress bar appears at
the bottom of the Profiling Tool window.

Note: In the print queue, 10 copies of the Warm-up chart file are printed first
and then 71 tabloid sheets of the standard profiling chart ILSECI2002 are
printed and measured. If Letter or A4 is selected then this amount is doubled.

The profile is created for the specific screening option that you
selected.

When the profile creation process is completed, a check mark
appears next to the screening method used to create the

profile.
6. Click Close, when the procedure is complete.

If you selected to save in Profile Manager, your new destination
profiles are saved in the Profile Manager and are automatically
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linked to the relevant media type in the Media and Color Manager
window.

Importing a destination profile

If you saved a profile in a location other than the Profile Manager,
you must first import it before you can print a job using it.

Note: After you import the profile the file becomes *.icm format.

1. From the Tools menu, select Resource Center.

The Resource Center window appears.
2. In the Resource list, select Profile Manager.
3. Click the Destination Profile tab.
4. Click the Import (+) button.
5. In the Destination profile area, click the Browse button.
6. Click Import and browse to the location of the required

destination profile, and then click Open.
The new destination file is displayed in the Destination Name
box; if you would like to change the name you may do so.

7. Click Import.
The new destination profile is added to the Color Flows tab in
the job parameters window.

Importing a source profile
Source profiles are used to emulate other devices, or color
spaces. You can import source CMYK or RGB profiles.

1. From the Tools menu, select Resource Center.

The Resource Center window appears.
2. In the Resource list, select Profile Manager.
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3. Select Source Profile tab.

4. Click the Import button.
5. In the Source profile area, click the Browse button.
6. Locate and select the required source profile, and then click

Open.
The new emulation name is displayed in the Emulation name
box; if you would like to change the name you may do so.

7. Click Import.
The new source ICC profile is added to the Color Flows tab in
the job parameters window.

Mapping media using the Media and Color
Manager tool

The Media and Color Manager is a tool that automatically maps
the media type and weight to a destination profile, screen and
calibration table.

You can change the destination profile, screen and calibration
table for each of the different media types listed in the Media and
Color Manager. The CX print server is configured with a default
recommend profile.
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Note: The destination profile is applied to the selected media type during the
RIP.

1. In the Resource Center, select Media and Color Manager.

2. Select the media type from the list on the left.
3. On the right-hand area of the Media and Color manager

window, select the desired screen, profile, and calibration table
that you want to map to your paper stock.

4. In the Profile list, select the desired profile.
5. In the Calibration list, select the desired calibration table.
6. Click Close.
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Next: To apply this profile with the media type in your job, in the
job parameters window select Color > Color Flow. In the
Destination area, select Linked in the Destination Profile list.

See also:
Mapping jobs to calibration tables on page 21

Managing calibration tables

Calibrations window
You can edit and view any of the calibration look-up tables (LUTs)
that are stored on the CX print server. You can find the calibration
table information in Tools > Resource Center > Calibrations.

Calibration table list
The following calibration tables are listed:
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● Calibration tables created in the Calibration Wizard.
● None: This is a default option and cannot be edited. Jobs that

have this option selected are processed and printed without
using a calibration table.

● Normal (default table): This is a default table and cannot be
edited. If a calibration table has not been created for the media
type, Normal weight, and screening method that you are using,
the Normal calibration table is used when you process and print
your job.

Info Data

Output Density

Measured: The values that are measure from the printed
target.
Target: The expected values of the output density.
Minimum Accepted: The minimum measured value of the
output density that is accepted for correction.

Properties

The parameters that were selected when the calibration
table was created.
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Info Graph

During printing, the CX print server automatically replaces the
CMYK values in the RTP file with new values that compensate for
the printer’s current performance level.

Separations

The graph displays cyan, magenta, yellow, and black
separations. You can see information about each
separation by clicking the desired separation button. Or you
can view all the separations together, by clicking the button
that shows all four colors.

Output Density

The vertical axis represents the dot percentage values of
the final output data (after applying the calibration table)
that is sent to the printer.

Input %

This horizontal axis represents the dot percentage values of
the RTP file.

Adding an entry to a calibration table
You can review a calibration table to make sure that the curves are
relatively smooth and continuous. If you are not satisfied with the
results, the Edit option enables you to adjust the values of the
image in the value table.

1. From the Tools menu, select Resource Center.
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2. In the Resource list, select Calibrations.
3. Select the calibration table that you want to add an entry, and

click the Editor tab.

4. From the Separation list, select the desired separation to that
you want to add an entry.

The file and printer values for the separation that you selected
appear in the File Value and Printer Value lists.

5. Select a row in the value table, and click the Add (+) button.
6. In the Add Entry window, from the File Value and Printer

Value lists, select the desired values.

7. Click OK.
The value table is updated, and the calibration graph is adjusted.

8. To save your changes, click the Save button.

Managing spot colors
You can define a specific color as an RGB, CMYK, or Gray spot
color and enter a fixed CMYK target.
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Individual job pages can contain RGB, CMYK, and spot color
elements. A spot color is a specially mixed ink that enables you to
reproduce colors that are difficult to reproduce with CMYK inks.

The CX print server Spot Color Editor enables you to edit the
values of every spot color in the Spot color dictionary. You can edit
these values without affecting the graphics, images, or lineart
page elements.

When a spot color is converted to CMYK for digital printing, the
printout doesn’t always simulate the desired spot color. The spot
color variations feature enables you to easily edit a spot color by
selecting a more appropriate shade. The spot color variations
feature provides 37 variations, with slightly different CMYK values.

The spot color variations feature enables you to set:

● The variation of cyan, magenta, and yellow dot percent, by
selecting variations of 1-7%. The default selection is 2%.

● The change in the hue, by selecting variations in the cyan,
magenta, yellow, red, green, and blue axis.

● The brightness, by increasing or reducing the K value by up to
20%.

You can assess your changes immediately in the Before and
After boxes, or you can print the entire set of variations, and
decide which best fits your requirements by examining the
printout. The edited spot color is saved in a custom dictionary.
When the CX print server identifies a spot color in a job, it first
looks for the name of the spot color in the custom dictionary and
uses the associated CMYK values. If the spot color is not found, it
looks in the PANTONE® color and HKS® color dictionaries. If the
spot color is not found in either dictionary, the CX print server uses
the CMYK values embedded in the original file.
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Adding a spot color
1. From the Tools menu, select Spot Color Editor.
2. In the Spot Color Editor dialog box, click the add (+) button.

3. Type the new color name as it exists in the original file.

Note: The spot color names are case sensitive and should match the name
as it appears in the DTP software.

4. Adjust the CMYK values as required.
5. Click Save.
6. Click Close.
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The new color is added to the custom color dictionary.

If you created a new spot color for an RTP job, make sure you re-
RIP the job before printing.

Editing a spot color

1. From the Tools menu, select Spot Color Editor.
2. Do one of the following actions:

● In the Color list, search for the desired color.
● In the Spot color dictionary list, select the color dictionary

that contains the color you want to edit.

Note: Use the PANTONE® C dictionary if you are working in an
application such as Adobe InDesign® software.

3. Highlight the required color.
The color's CMYK values and color preview appear in the right
hand side of the Spot Color Editor window.

4. Change the CMYK values as required.
5. Click Apply.

The new color is added to the custom color dictionary.

Deleting a spot color

You can only delete spot colors from the custom color dictionary.

1. In the Spot dictionary list, select Custom Dictionary.
2. From the list of custom colors, highlight the color you wish to

delete.
3. Click remove (x) icon.
4. Click Yes to delete the color.

Printing a spot color chart
Setup and print a spot color chart in order to test the output.

In order to make sure that the spot colors will print correctly you
can send a test print of selected spot colors. According to the
results of the print out you can then make the necessary
adjustments to the spot colors using the Spot Color Editor.
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Note: You can only print a spot color chart for CMYK values.

1. From the Tools menu, select Spot Color Editor.
2. Click Test Print.

3. Select a Spot color dictionary from the list and then select
the pantone patches that you want to print.

4. Click Print, and then select the following:

● In the Screening list, select the desired screening method.
5. Click Print, to print the spot color test chart.

Spot color variations overview
A spot color is a specially mixed ink that enables you to reproduce
colors that are difficult to reproduce with CMYK inks. When a spot
color is converted to CMYK for digital printing, the printout doesn’t
always simulate the desired spot color. The spot color variations
feature enables you to easily edit a spot color by selecting a more
appropriate shade. The spot color variations feature provides 37
variations, with slightly different CMYK values.
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The spot color variations feature enables you to set:

● The variation of cyan, magenta, and yellow dot percent, by
selecting variations of 1-7%. The default selection is 2%.

● The change in the hue, by selecting variations in the cyan,
magenta, yellow, red, green, and blue axis

● The brightness, by increasing or reducing the K value by up to
20%.

You can assess your changes immediately in the Before and After
boxes, or you can print the entire set of variations, and decide
which best fits your requirements by examining the printout.

The edited spot color is saved in a custom dictionary. When the
CX print server identifies a spot color in a job, it first looks for the
name of the spot color in the custom dictionary and uses the
associated CMYK values. If the spot color is not found, it looks in
the spot color dictionaries. If the spot color is not found in either
dictionary, the CX print server uses the CMYK values embedded
in the original file.

Selecting a spot color variation

1. From the Tools menu, select Spot Color Editor.
2. In the Color list, type the name of the spot color.

The spot color is automatically selected from the spot Color list.

3. Click the Variations  button.

The Variations dialog box appears. The spot color is in the
center of the color patches and is designated as "0".

4. Click and slide the Variation steps slider to see the different
variation steps between 1 to 7 color units of the original value.
Each unit refers to a dot percentage of the original value.

5. To see the CMYK values of a color patch, roll your mouse over
the color patch.

The CMYK values appear in the bottom left corner of the
dialog box.

6. To select a variation of the spot color, click on the desired color
patch.

You can see the difference between the selected color patch
and the original spot color in the Before and After box.
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7. To select a different brightness setting for the selected color
patch, click a color patch under Brightness.

The K value of the selected color patch is increased or
decreased according to your selection.

8. Click Select.
9. Click Apply.

The spot color with the new values is added to the Custom
Dictionary.

10. Click Close.

Printing a spot color variation
Requirements: Make sure that the printer is connected and
turned on and all the queues on the CX print server are ready for
processing and printing.

1. From the Tools menu, select Spot Color Editor.
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2. In the Color list, type the name of the spot color.

The spot color is automatically selected from the spot Color list.

3. Click the Variations  button.

The Variations dialog box appears. The spot color is in the
center of the color patches and is designated as "0".

4. Select the desired color patch.
5. Click Print Variations.

6. Do the following:

● In the Tray list, select the desired tray.
● In the Screening list, select the desired screening method.
● In the Calibration list, select the desired calibration table.
● To print the variations with no background, clear the Print

with background check box.
7. Click Print.

See also:
Color tab in the Job Parameters window on page 110

Protecting specific spot colors
Using the Spot Color Editor, you can protect specific colors—for
example, official logos or company colors—to help produce color
fidelity and color consistency between devices. When you define a
specific color as an RGB, CMYK, or Gray spot color and enter a
fixed CMYK target for it, the CX print server treats it as a spot
color, protecting it accordingly.

Note: In order to apply this your job, In the job parameters window, in the
Color tab, select Protected Colors, and then select the check box for either
the RGB, CMYK, or Gray protected colors.
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Defining an RGB color as a spot color
The RGB spot workflow applies to line work, graphic, and text
elements.

1. From the Tools menu, select Spot Color Editor.
2. In the  Spot Color Editor dialog box, click the Protect RGB tab.
3. Click add (+).

4. In the Color name box, type a name for your color.
5. Type the RGB source values and the CMYK target values,

or select a spot color from the Entire Predefined List.
6. Click Save.
7. On the Protect RGB tab, select the color.

The color information appears.

8. If necessary, in the Corrected column, adjust the CMYK values.
9. Click Apply.

Defining a gray color as a spot color
The gray spot workflow applies only to line work and text elements.

1. From the Tools menu, select Spot Color Editor.
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2. In the  Spot Color Editor dialog box, click the Protect Gray tab.

3. Click add (+).

4. In the Color name box, type a name for your color.
5. Enter the Gray source value and CMYK target value, or

select a spot color from the Entire Predefined List.
6. Click Save.
7. On the Protect Gray tab, select the color.
8. If necessary, in the Corrected column, adjust the CMYK values.
9. Click Apply.

Defining a CMYK color as a spot color
The CMYK spot workflow applies only to line work and text elements.

1. From the Tools menu, select Spot Color Editor.
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2. In the  Spot Color Editor dialog box , click the Protect CMYK
tab.

3. Click add (+).
4. In the Color name box, type a name for your color.
5. Enter the CMYK source value and CMYK target value, or

select a spot color from the Entire Predefined List.
6. Click Save.
7. On the Protect CMYK tab, select the color.
8. If necessary, in the Corrected column, adjust the CMYK values.
9. Click Apply.

Color adjustment with the Gradation Tool

Sometimes you need to perform tone corrections when you print a
job. The CX print server enables you to create a gradation table
that will correct your printed output. Changes in gradation can
include brightness, contrast, and color balance adjustments
throughout the tone range of an entire image or in specific tone
ranges.

The Gradation Tool window enables you to create and edit
gradation tables as well as visually check the effect of your
gradation tables on a specific processed job. The new gradation
tables you create are added to the Gradations list in the Color
parameter and can be applied to print jobs.

To open the Gradation Tool window:

From the Tools menu, select Gradation or click on the Gradation
Tool icon from the toolbar.
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Previewing a job
1. From the Tools menu, select Gradation.
2. Next to the Preview File box, click Browse.
3. Select the job that you want to preview, and then click Open.

The Original and Edited views display your job.

Creating a new gradation table
1. From the Tools menu, select Gradation.
2. In the Gradation Tool window, modify your gradation table as

required.
3. Click Save .
4. In the Table name box, type the name of the new gradation table.
5. Click OK.

The gradation table is saved and added to the Gradation Table
list and to the Color Adjustments tab in the job parameters window.
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Editing a gradation table

When you open the Gradation Tool, the default gradation table,
DefaultGradTable, is selected in the Gradation Table list, and is
displayed in the graph. This table serves as a baseline and
consists of a 45° gradation curve, with Brightness and Contrast set
to 0, and Contrast Center set to 50. All of the color separations are
selected.

The Gradation Table list includes four other predefined gradation
tables:

● Cool: Blue tones appear clearer
● Lively: Increases the color saturation
● Saturated: Increases the strength (chroma or purity)
● Sharp: Increases the contrast
● Warm: Sets the hues in the low densities to a bright reddish color

Gradation tables that you create or edit also appear in the
Gradation Table list. When you select a gradation table, the
predefined settings are immediately applied to the processed job
that you are working with. The Separations buttons enable you to
select one, all, or any combination of separations to edit for a
specific gradation table. Selecting a specific separation enables
you to change the color balance for a specific tonal orange. When
you open the Gradations Tool window, all of the separations are
selected.

Note: When you change gradation table definitions in the Gradation tool and
click Refresh, you will notice that the changes have affected the image in its
entirety. However, despite what you see in the Edited view, changes made to
the gradation tables do not affect spot colors.

1. From the Tools menu, select Gradation.
2. To edit the separations, do one of the following:

● Click the All Colors button  to edit all the separations
simultaneously.

● Click the individual separations you wish to edit—for
example, select the cyan separation only.

3. Click the curve in the graph to add a point, and then drag the
point to modify the separation.
The value appears in the Input or Output boxes.

4. To view gradation changes in your job, click Refresh.
Changes are automatically applied to the displayed image in
the After view.
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5. To remove a point on the curve, select the point and then click
Remove.

6. To reset the gradation curve to a 45° curve, click Reset.
7. To revert to the original gradation settings, click Revert.
8. To remove the last change you made to the gradation graph,

click Undo.

Correcting an image using Photo Touch-up

The photo touch-up options correct common flaws found in JPEG
RGB format images in PDF files.

1. Open the Job Parameters window for the desired job.
2. In the Photo Touch-Up tab, select Photo Touch-Up.
3. Select Apply photo touch-up options.

4. Select one or more photo touch-up options.
The image is corrected according to the selected options as
follows:

● Exposure and color cast:
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Correct underexposure, overexposure, and minor color-cast
problems in photos.

● Image noise:

Reduce noise (such as granularity caused by high ISO
settings) in a photo.

● Shadows and highlights:

Bring out details in the dark and light areas of a photo.
● Red-eye:

Remove the red-eye effect in photos taken with a flash.
● JPEG artifacts

Remove JPEG artifacts often found in low-quality or highly
compressed JPEG files, particularly in gradient and vignette
areas and around the edges of objects.

5. Select Submit.
The job is sent to the Process Queue.
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8 Production workflows

Print using imposition

Imposition overview
Imposition is the process of positioning page images on a virtual
sheet of paper so that when a printer or digital printing press prints
the sheet, the page images will be in the right order. It is part of the
process of producing finished documents.

In addition to page images, you can add various marks to the
sheets to aid the production process. These marks show where the
paper should be folded or trimmed.

Imposition does not affect the content of the individual page but
rather affects only the placement of the page images on a press
sheet. Imposition is a combination of content and layout. The
content is the pages that should be printed, and the layout is the
location of the page on the sheet, along with the page’s printing
marks, crop marks and fold marks.

See also:
Imposition tab in the Job Parameters window on page 104

Imposition methods
The CX print server provides the following imposition methods:

Step and repeat: The step-and-repeat method is the most efficient
one when you want to print multiple copies of the same image and
fill each sheet to capacity—for example, many business cards on
one sheet.



Step and continue: The step-and-continue method enables you
to place different pages of a job on one sheet so that the sheet is
filled to capacity.

Cut and stack: The cut-and-stack method is used to print, cut,
and stack pages while preserving a certain order. When the cut
stacks are piled one on top of the other, the entire job ends up in
the desired order. The cut-and-stack method is useful primarily for
high-volume variable information jobs.

Saddle stitch: The saddle-stitch method prints pages in a manner
that is suited for saddle-stitch binding. With this binding method,
sheets are folded, inserted one inside another, and then stitched
or stapled along the spine, such as in a brochure or magazine.

Perfect bound: The perfect-bound method prints pages in a
manner that is suited for perfect binding. Perfect binding is a book-
finishing technique in which the folded sheets are gathered in
order and clamped into place. A saw roughens the spine edge of
the gathered pages. Glue is then applied to the spine, and the
cover of the book is affixed to the glued spine. This method is
used for most books.

Previewing an imposition layout
The Preview window enables you to view your imposition layout
and settings.

Requirements:

An imposition method must be selected.
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You can open the Preview window at any time and keep it open to
check your imposition settings as you select them. The Preview
window dynamically reflects any changes that you make.

1. Open the Job Parameters window for the desired job.
2. Click the Imposition tab, and make sure that an imposition

method has been selected.
3. Click the Preview button.

The Preview window appears.

Imposition layout Preview window

Preview window buttons

Front Click to view the front pages.

Back Click to view the back pages.

Navigation
buttons

Click the navigation arrows to move between
sheets.

Navigation box
Jump to a specific sheet by typing a number in
the navigation box.

Page image

Gray arrows Indicate the direction of the pages on the sheet.

Page numbers Indicate the numbered sequence of the pages.
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Imposition Conflict
If any parameters conflict, Imposition Conflict appears in red in
the Preview window and also on the Imposition tab.

Conflict
indications A red border along the edge of the page

indicates where the conflict exists.

● If the red border appears along the upper
and lower edges of the page, a conflict
exists in the height value.

● If the red border appears along the left and
right edges of the page, a conflict exists in
the width value.

Problematic values appear in red.

Printing a business card job
Requirements:

This example assumes that your job contains one-sided business
cards that are 50 mm × 90 mm (1.96 in. × 3.45 in.), imposed on A3
paper.

This example demonstrates how to use the Step & Repeat
imposition method to print business cards. With the Step &
Repeat method, you can print multiple copies of the same image
on one large sheet.

1. Click the suspend button to suspend the Process queue.
2. From the File menu, select Import.
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3. Import your business card file to the ProcessPrint virtual printer.
The file is imported to the Process queue with a Waiting status.

4. In the suspended Process queue, double-click the business
card file.
The Job Parameters window appears.

5. In the Job Parameters window, under Print, select the Paper
Stock parameter.

6. In the Paper size list, select 11 x 17.
7. Click the Imposition tab.
8. In the Imposition Method list, select  Step & Repeat.
9. Select the Size parameter, and set the values as follows:

a. For Trim Size, select Custom
b. For H, type 1.96 inches or 50 mm
c. For W, type 3.54 inches or 90 mm
A preview of the layout is displayed below.

10. For  Trim orientation, make sure that the Landscape option
is selected. To change the trim orientation, in the Job
Parameters window, select Print and then select Layout.
Select the desired orientation.

11. Select the Templates parameter, and set the values as follows:
a. In the Layout list, select Best Fit. The CX print server

determines how many business cards can fit on each sheet.
The CX print server calculates the best fit.

b. For Print Method, make sure Simplex is selected, since
your business cards are one-sided.
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12. Click the Preview button to preview the layout.

The Preview window appears, displaying a schematic
representation of your imposition layout. The layout of three
columns by eight rows appears with no imposition conflict.

13. Leave the Preview window open, and, if necessary, drag it to
the right.

14. Select the Spacing & Marks parameter.
15. In the Marks list, select Crop marks.

The crop marks automatically appear in the Preview window
and the Margins size is automatically increased to
accommodate the crop marks.

16. In the Gutter box, type 0.2 inches or 5 mm.
As soon as you change the value for the Gutter size, the
imposition layout in the Preview window automatically
changes. The CX print server calculates that to accommodate
a gutter of 0.2 inches or 5 mm, a layout of three columns by
seven rows will best fit on each sheet.

17. Check the Preview window. No imposition conflicts appear.
18. In the Job Parameters window, click Save.
19. Release the suspended Process queue.

Your business cards are processed and printed according to
the imposition settings.

Printing a saddle stitch job
Requirements:

This example assumes the following:

● Your job is an eight-page brochure, with a custom trim size of
5.27 by 3.34 inches or 134 by 85 mm.

● Tabloid or A3 paper is loaded in the printer.

This example demonstrates how to use the Saddle Stitch
imposition method to print two sets of the same job on one press
sheet to save paper and production time.

1. In the Storage area, double-click your job.
2. In the Job Parameters window, click the Imposition tab.
3. In the Method list, select Saddle stitch.
4. In the Sets per sheet list, select 2 to print two sets of your

imposed job on one press sheet.
5. Click Spacing & Marks.
6. In the Marks list, select Crop marks.
7. In the Bleed box, type 0.118 inches or 3 mm.
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8. Click the Preview button.

A schematic representation of the imposition layout appears.

Note: When you print your job, a space of 0.39 inches or 10 mm is
automatically added between the two sets on the sheet.

9. Close the Preview window.
10. Click Submit.

Your job is processed and printed according to the imposition
settings for two sets per sheet. You have used most of the
sheet's space and saved on paper. You can also easily cut and
staple the two brochures.

Imposition Template Builder Tool

Imposition Template Builder overview
The Imposition Template Builder enables you to save imposition
layouts and reuse them for different jobs, without needing to define
the same layout repeatedly. The Imposition Template Builder also
allows you to create and save templates with special layouts that
cannot be created on the Imposition tab alone.

After you save a template, you can apply it to a specific job.

All saved templates appear on the Imposition tab. After you
select an imposition method, the related templates appear in the
Template parameters, in the Layout list. For example, if you
created a Step & Continue template, the template appears in the
Layout list only when you select the Step & Continue imposition
method.

Some templates appear under more than one imposition method.

Method selected on
Imposition tab:

Template layout type in the layout list:

Step & Repeat Step & Repeat, Cut & Stack

Step & Continue Step & Continue

Saddle Stitch Saddle Stitch, Perfect Bound

Perfect Bound Saddle Stitch, Perfect Bound

Creating an imposition template
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On the CX print server, you can use the Imposition Template
Builder to create templates for similar types of jobs that have the
following imposition settings in common:

● Imposition method
● Columns and rows
● Simplex/duplex
● Binding

For example, if you want to create an imposition template for A4-
sized brochures printed on A3 paper, you could create a template,
called “A4Brochure”, and select the following settings:

● Imposition method: Saddle Stitch
● Columns: 2
● Rows: 1
● Type: Duplex (selected by default)
● Binding: Left

You would define all the other imposition settings—for example,
Trim Size, Bleed, Margin, Gutters,Paper Type, and Sheet Size—
on the Imposition tab.

1. From the Tools menu, select Imposition Template Builder.
2. From the Method list, select an imposition method.
3. Click the New (+) button.
4. Type the name of the new template, and press Enter.
5. In the Layout area, type the number of columns and number

of rows that you need.
The imposition method that you select determines the number
of columns and rows that you can enter. For Saddle Stitch
and Perfect Bound, you can place up to 64 pages on one
sheet (8 × 8). For Step & Repeat and Step & Continue, you
can place up to 625 pages on one sheet (25 × 25).

6. Under Type, select Simplex or Duplex.
7. Under Orientation, select Portrait or Landscape.

Note: The Orientation setting in the Imposition Template Builder is for
display purposes only. This parameter is not saved in the template. (You set
job orientation on the Imposition tab, under Size).

8. From the Binding list, select the appropriate binding method.

Note: Binding is available only when Saddle Stitch and Perfect Bound
imposition methods are selected.

9. Click Save.

Imposition template viewer window
As you create or modify a template, you can see your template in
the template viewer. As you select parameters, the template
viewer dynamically changes to reflect your selections.
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Buttons

Notes:

● When Simplex is selected, only the Front view is available.
● Sheet size is set on the Imposition tab. The sheet size that appears in

the template viewer is dynamic. It changes to accommodate the
parameters that you choose.

Front Click to view the front pages.

Back Click to view the back pages.

Both Click to view both the front and back pages
simultaneously.

Editing an imposition template

Rotating a page 180 degrees

The template viewer enables you to rotate one or more pages and
change the location of pages on the sheet.

The gray arrow on each page indicates the top of the page. The
page number is indicated by the number that appears on each page.

1. Make sure the Apply changes to front and back check box
is clear.

2. Select the desired page.

Note: To select multiple consecutive pages, click the first page, press and
hold Shift, and then click the last page. Select multiple non-consecutive
pages by pressing and holding Ctrl as you click each page.

3. Click the Rotate 180 button.
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Rotating both the front and back sides of a page 180 degrees

1. Select the desired page.
2. Select the Apply changes to front and back check box.
3. Click the Rotate 180 button.

Changing the position of a specific page on a press sheet

You can change the location of a page on a sheet as needed.
Changing the location of a page is often necessary when the Step
& Continue  imposition method is selected.

1. Click the target location that you want to move the page to—
for example, click page 10 if you want to place a different page
in that location.

The target location turns blue when selected.

2. Click the Page Number box, and type the number of the page
that you want to move to the target location. For example, you
would type 5 to place page 5 in the location of page 10.

3. Press Enter.

The page moves to its new location.
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Note: The page number that was previously in the target location is not
automatically moved to another location. To retain this page, manually move
this page to a new location.

If you have a duplex job and the Apply changes to front and back check
box is selected, the page number for the back side of the page also
changes. Using the example above, page 6 would be on the back side of
page 5.

Simulating a job with your template
You can simulate how jobs from the Storage window will look if
you apply an imposition template to them.

Note: The imposition template parameters are not actually applied to the job
—you are viewing only a simulation of how the job would look if this template
were selected on the Imposition tab.

1. In the Imposition Template Builder window, click the Simulate
button.

2. Click Browse.
3. Select a job, and then click Select.

The parameters of the job (Sheet Size, Trim Size, Trim
Orientation, Sets per sheet, Bleed Size, Rotate 90, Crop
Marks, and Fold Marks) appear with their values in the
Simulate Imposition window.

Note: Both RTP and non-RTP jobs are available for simulation.

4. Change the parameters as desired.
5. Click View Simulated Job.

The Preview window appears. A simulation of the job is displayed
with the current imposition template applied.

Print with exceptions

Adding exceptions to your job

Exceptions are used when you want to use different media types
for special exceptions within a job, or add inserts.

Note:

1. Open the Job Parameters window of your job.
2. Click Exceptions.
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3. In the Type list, select the pages in your job in which the media
type will be different.

4. Depending on the option you selected in the Type list, perform
one of the following steps:
● For Page range, type the page range in the box.
● For Front cover or Back cover, select the Duplex check

box to print the first two (or last two) pages of the job as the
cover page (back cover).

Note: If the imposition type is Saddle Stitch, select Cover to print both
a front and back cover page on a different media type. Select Middle
sheet to print the internal sheets on a different media type.
● For Inserts, select Before or After and type the page

number that will precede or follow the insert. Then, in the
Quantity box, type the total number of inserts you want to
add.

5. Click Advanced Options.
6. In the Destination profile list, select a destination profile. You

can select per page or a range of pages.
7. Under Image Position, do one of the following:

● To have the image position be the same as the rest of the
job, make sure the Same as job check box is selected.

● To shift the image on the second side of the sheet
according to the image shift on the first side of the sheet,
select the Same on Both Sides check box.

8. Click Save.
9. Click Apply.
10. Click Save or Submit.

Deleting exceptions from your job
1. Open the Job Parameters window of your job.
2. Click Exceptions.
3. Select the exception that you want to delete.
4. Click Remove.

Dynamic page exceptions and setpagedevice commands
Note: The dynamic page exceptions is only available with the Professional
Power Pack.

A setpagedevice command is a standard PostScript command that is
embedded in a file and enables you to print a complex job that
contains paper of varying size, coating, weight, and so forth. Such
commands indicate that the printer must switch media during the
printing of a job. When a job is RIPed, the CX print server
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identifies the setpagedevice commands and maps them to the
selected types of paper. The printer then uses those types of
paper for the job.

Page exceptions and inserts that include setpagedevice commands
are called dynamic page exceptions. The CX print server supports
dynamic page exceptions for the following file formats:

● PostScript
● VPS
● PDF

Printing dynamic page exceptions
Requirements: 

A file with embedded setpagedevice commands.

1. From the Tools menu, select Resource Center.
2. In the Resource list, select Virtual Printers and either create

a new virtual printer or edit an existing one.
3. Select the Support dynamic page exceptions check box.
4. Click Edit to open the Job Parameters window.
5. Under Exceptions, select the paper stock for each exception

or insert.
6. Import the file to the CX print server via the dedicated virtual

printer, and submit the job.

Note: If the virtual printer is based on either a ProcessStore Process or
SpoolStore Store virtual printer, you can perform a preflight check before the
job is printed.

The job is RIPed, and the setpagedevice commands are identified
and mapped to the selected types of paper.

Important:

● Virtual printers that support dynamic page exceptions do not support
regular page exceptions and imposition.

● A virtual printer that is dedicated to dynamic page exceptions can print
only jobs with dynamic page exceptions. Do not print other types of jobs
via that virtual printer.

● You can perform a preflight check on SPD commands. Make sure the
virtual printer has support dyynamic page exceptions selected.
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Print tabs using the Creo Color Server Tabs plug-
in for Acrobat

Tabs plug-in overview
The Tabs plug-in is a Creo plug-in, developed for use with Adobe
Acrobat. The Tabs plug-in enables you to create and place tabs in
your unprocessed job (PDF or PostScript), manage the tab and
text attributes, and save a set of attributes for future use.

Tabs plug-in window

Text attributes - tabs

Tabs
Size

The size of the tabbed sheet. By
default, the tab size for letter jobs is set
at 9x11, and for A4 jobs to A4+.

Type

The number and type of tabs that you
can select.

Note: If you want your tabs to be reversed—
that is for the lowest tab to be the first one—
select one of the reverse tab options.

Orientation
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Text attributes - tabs

Orientation of the tab.

Top Offset

The value for the distance between the
upper edge of the paper and the upper
edge of the uppermost tab.

Note: The units in the Tabs plug-in are set in
the Acrobat Preferences dialog box.

Bottom Offset

The value for the distance between the
lower edge of the paper and the lower
edge of the lowest tab.

Length

The length of the tab.

Width

The width of the tab.

Text attributes - text

Text
Font

The font for the tab text.

Size
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Text attributes - text

The font size for the tab text.

 Color

The color of the tab text.

 Bold

Bolds the tab text.

 Italic

Makes the tab text italic.

 Underline

Underlines the tab text.

Alignment

The alignment of the tab, according to
the orientation of the tab. The
orientation that you select determines
the alignment buttons that are displayed.

●  Align Left Portrait

●  Align Center Portrait

●  Align Right Portrait

●  Align Left Landscape

●  Align Center Landscape

●  Align Right Landscape

Offset

The value that adjusts the offset of text
on the tab. The x value moves the text
horizontally. The y value moves the text
vertically.

Wrap text
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Text attributes - text

Automatically wraps the text onto the
following ine when the entire text does
not fit on one line.

Text on both sides

The same text appears on both sides of
the tab.

Direction

Direction of the text.

●  Vertical

●  Counter-clockwise

●  Clockwise

Note: The Direction options are available
only for portrait jobs.

Content
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Content

# The tab number.

Before Page The page number that the tab precedes.

Text The text that appears on the tab.

Thumbnails
area A thumbnail view of the job with page

numbers and tabs indicated.

Remove Removes the selected page or tab.

Settings

Saved Settings Lists the saved settings files.

Save Saves the currently selected settings in a file.
This settings file can be applied to other PDF
or PostScript files.

Delete Deletes the selected settings file.

Creating tabs
Requirements:

You can only create tabs in a PDF or PostScript file.

1. In the Storage window, right-click your unprocessed job, and
select Job Preview&Editor.

The job opens in Acrobat software.
2. From the Plug-Ins menu, select Tabs Printing.

The Tabs Printing window opens, displaying the Text
Attributes tab.
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3. In the Tabs area, set the tab attributes.
4. (Optional) In the Text area, set the attributes of the text on the

tabs.
5. Click the Content tab.

6. In the Before page column, click the first cell and type the
number of the page that you want the tab to precede.
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7. In the Text column, type the text for the tab.

The tab appears in the thumbnail area.

8. To add more tabs, repeat steps 6 and 7.
9. Click Apply to apply the tab settings to your document.

The Tabs Printing window closes, and the tabs that you added
become part of the document.

10. From the Acrobat File menu, select Save, and then close
Acrobat.

11. Process and print the job.

Managing tabs

Changing the location of a tab

1. In the Storage window, right-click your unprocessed job, and
select Job Preview&Editor.

The job opens in Acrobat software.
2. From the Plug-Ins menu, select Tabs Printing.

The Tabs Printing window opens, displaying the Text Attributes
Text Attributes tab.

3. Click the Content Content tab.
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4. In the thumbnail area, click the tab that you want to move, and
drag it to the desired location.

The tab moves to the selected location and the tab numbers
are updated accordingly.

Replacing a page with a tab
1. In the Storage window, right-click your unprocessed job, and

select Job Preview&Editor.

The job opens in Acrobat software.
2. From the Plug-Ins menu, select Tabs Printing.

The Tabs Printing window opens, displaying the Text Attributes
Text Attributes tab.

3. Click the Content Content tab.
4. In the table, type the tab text.

The page is deleted from the document, and replaced with a tab
page.

Inserting a tab before or after a specific page
1. In the Storage window, right-click your unprocessed job, and

select Job Preview&Editor.

The job opens in Acrobat software.
2. From the Plug-Ins menu, select Tabs Printing.

The Tabs Printing window opens, displaying the Text Attributes
Text Attributes tab.

3. Click the Content Content tab.
4. In the thumbnail area, right-click the page and select Insert

tab before page or Insert tab after page.

Removing a page or tab from the file
1. In the Storage window, right-click your unprocessed job, and

select Job Preview&Editor.

The job opens in Acrobat software.
2. From the Plug-Ins menu, select Tabs Printing.

The Tabs Printing window opens, displaying the Text Attributes
Text Attributes tab.

3. Click the Content Content tab.
4. In the thumbnail area, right-click the page or tab that you want

to remove, and select Remove.

Saving the tab settings
Requirements:

You have created tabs in a PDF or PostScript file.
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After creating tabs in your file, you can save the tab text attribute
settings and the tab locations and captions (text on the tab).

1. In the upper part of the Tabs Printing window, click Save.

2. In the Setting Name box, type a name for the tab settings.
3. Select the Include Tab location and Caption check box to

save the locations and text of the tabs that you created.
4. Click Save.

The setting is saved in the Saved Settings list.

Note: You can apply this saved setting to your file by selected this from the
Saved Settings list, and then click Apply.

Deleting saved tab settings

1. In the Storage window, right-click your unprocessed job, and
select Job Preview&Editor.

The job opens in Acrobat software.
2. From the Plug-Ins menu, select Tabs Printing.

The Tabs Printing window opens, displaying the Text Attributes
Text Attributes tab.

3. From the Saved Settings list, select the desired saved settings.
4. Click Delete.
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9 Variable data printing
jobs

Variable Data Printing jobs
Variable Data Printing (VDP) is a form of on-demand digital printing
that produces customized or personalized documents targeted to a
specific individual. Within a single document design, elements such
as text, graphics, and images are changed from one printed page
to the next based on recipient information garnered from a
database. These documents can include bills, targeted advertising,
and direct mailings.

VDP jobs are composed of booklets, which are personalized
copies of a document. A booklet can consist of one or several
pages, but the entire document is targeted at a specific individual
or address. For example, a booklet can be either a single-page gas
bill or a multi-page personalized document.

Each page in the booklet is constructed as a collection of
individually RIPed elements that may differ from booklet to booklet,
including text, graphics, pictures and page backgrounds. These
elements are self-contained graphical entities that may be line art,
text, RIPed images, or a combination of these. There are two types
of elements in VDP jobs:
● Unique elements are used only once for a specific individual or

purpose. An individual's name is an example of a unique element.
● Reusable VDP elements can be used more than once in

different pages, booklets, or jobs. A company logo is an
example of a reusable element.

Pages are assembled from the pre-RIPed reusable elements and
the RIPed unique elements just before printing. Then the job is
printed in the same way as all other jobs.

About VDP document formats
VDP jobs are created using VDP authoring programs that support
Variable Print Specification formats. Most VDP authoring programs
can convert VDP files to conventional PostScript files, which can
also be processed by the CX print server although less efficiently
than Variable Print Specification files. Each authoring program
creates VDP code that instructs the RIP where to place the VDP



elements and each authoring program does so in a slightly
different manner.

The format you choose can be a stand-alone format that covers all
aspects of document design, data management and text capture
or it can be an extension of an existing program that enables the
creation of VDP documents and VDP jobs.

The CX print server can process VDP jobs that are in one of the
following file formats:

● Creo Variable Print Specification (VPS)
● Personalized Print Markup Language (PPML)
● Variable Data Exchange (VDX)
● PostScript
● Xerox Variable data Intelligent Postscript Printware (VIPP)

Note: PostScript files are suitable for simple, very short run jobs. All page
elements are re-RIPed for each page. These jobs do not use a VDP
authoring tool at all. Instead, they use a mailmerge function in a Microsoft
Word document or a Microsoft Excel® spreadsheet.

About Variable Print Specification
The Variable Print Specification (VPS) file format is the formal
language developed for Creo color servers. It was designed for the
effective production of Variable data printing (VDP) documents.
The file format is comprehensive and can specify a complete
range of VDP documents. It also provides the means for efficient
implementation—fast and efficient data processing, and storage
prior to printing.

A variable print specification job consists of the following
components:

Booklet

A personalized copy of a document within a single print run
where pages and/or elements within a page may vary from
booklet to booklet.

Sub-job

All copies of a particular document—for example, book,
brochure, or flyer—within a single print run. On the CX print
server, sub-jobs can be deleted, archived, or reprinted at
any time. However, you can still maintain reusable elements
for future runs. Reusable elements are cached elsewhere,
so only the unique data, which is embedded in the job, is
deleted.

Reusable Elements
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Self-contained graphical entities that can be line art, text,
raster images or a combination of these types. Reusable
elements are represented in PostScript and can be stored
as EPS files when appropriate. Reusable elements include
clipping and scaling instructions as well as the image data.

Inline Elements

Unique information is drawn from a database and is
embedded in the sub-job. This data prints only once for
individual booklets.

About PPML
Personalized Print Markup Language (PPML) is an XML-based
industry standard print language developed by some of the world's
leading manufacturers of print technology for the high-speed
reproduction of reusable page content. It is an open,
interoperable, device-independent standard that enables the
widespread use of personalized print applications. Various
vendors have created software applications that can generate
PPML files.

The CX print server supports PPML formats. Some of the features
that are included enable you to:

● Process PPML jobs efficiently
● Import jobs in various VDP formats to the CX print server

PPML has a hierarchical structure. Document components are
separated from their submission file and can be organized and
stored in different levels of the hierarchical structure.

Managing VDP elements

Selecting to Cache Global VDP Elements

In order to manage your VDP elements, you need to make sure
that you select to cache your global VDP elements.

1. From the File menu, select Preferences.
2. Select General Defaults.
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3. Under Cache global VDP elements, make sure the Always
cache global VDP elements check box is selected.

4. Click Save.

Archiving VDP elements
If you have finished printing a large VDP job and you know that
you will need to reprint it in the future, you should archive the VDP
elements and retrieve them when needed. You can archive your
VDP job folder in a location that you specify.

1. From the Tools menu, select Resource Center.
2. In the Resource list, select Cached VDP Elements.
3. Select the VDP folder in which to archive, and then click

Archive.
4. In the Archive dialog box, select the location where you want

to archive your VDP elements.
5. Click Save.

The VDP elements are saved as cabinet files with the .Cab

 extension.

Next:

You also need to archive the variable RTP job.

Retrieving VDP elements
When you need to reprint your job, you can retrieve your archived
VDP elements.

1. From the File menu, select Retrieve from archive.
The Retrieve window appears.

2. Locate the folder in which your VDP elements are archived.
3. Select the desired file and then click the Add (+) button

Note: Use SHIFT or CTRL to select several files or CTRL +A to select all
the files.

4. Click Retrieve.
The CX print server retrieves the archived VDP elements and
displays them at the end of the file list in the Cached VDP
elements dialog box.

Next:

If you archived the variable RTP job, then you need to retrieve the
RTP job in order to print it.
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Deleting VDP Elements
VDP elements that are no longer in use take up valuable disk
space on the CX print server. To free up disk space, you can
delete the VI elements that you no longer need.

1. From the Tools menu, select Resource Center.
2. In the Resource list, select Cached VDP Elements.

Your VDP jobs are listed in the left pane. In the right pane, all
of the VDP elements that are associated with your job are
listed. In addition, a thumbnail viewer lets you check elements
visually.

3. Select the element that you want to delete, and then click
Delete.

Note: Select Delete All, in order to delete all the cached elements.
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10 Job parameters

Print tab in the Job Parameters window
Edit and change print parameters and options for your job.

Parameter Option Description

Copies and Pages Number of copies Enter the number of copies that you want to print. For
imposed jobs Pages changes to Sheets.

Pages Print range: Includes the following options:All, Odd pages,
Even pages, and Pages.

Note: For VDP jobs, the Pages option changes to
Booklets. For imposed jobs, instead of typing the desired
pages, type the desired number of imposed sheets.

You can select specific pages, booklets, or page ranges,
specify the pages or booklets to be printed as follows:

● Type one or several numbers separated by commas and
no spaces—for example, 1,3,5.

● Type a range of pages or booklets with a hyphen
between the starting and ending numbers in the range—
for example, 1-5.

Print Method Print method ● Simplex: For single-sided printing.
● Duplex head to head: For printing book-style hard copies

(usually used with portrait jobs).
● Duplex head to toe: For calendar-style hard copies

(usually used with landscape jobs).

Print mode The following options are available:

● Composite: (default setting) Prints the job without
separations. Each page of the job is printed once.

● Separations: Prints the job with color or grayscale
separations. If you select color separations, each page
in the job is printed in four colors: cyan, magenta, yellow,
and black. If you select grayscale, each page in the job
is printed separately four times in difference shades of
gray (K).

● Progressive: Prints each page of the job four times in
progressive color separations.

● Custom: Enables you to select the separations that you
want to print each sheet for each page of the job.



Parameter Option Description

Paper stock The following options are available:

● Use Paper Stock: Select the desired paper stock. If you
select Undefined, you can set the desired parameters in
the Paper size, Media type, and Media weight lists.

● Paper size: The paper size that you want to use. For
custom paper sizes, you need to specify the required
width and height.

Note: The units of measurement (mm or inches) are
selected in the Localization tab in the Preferences
window.

● Mixed paper size: Select check box if the job contains
different paper sizes.

Note: This option enables you to print jobs that contain
different paper sizes and orientation.

Interleaves Interleaves: Select Add Interleaf and then select the size
and stock that you want to use.

Gallop Enables you to start printing a long job, usually VDP, while
the job is still processing. The following options are available:

● Print after: Gallop enables you to begin printing a
defined number of pages while the job is still processing.

● Pages: The number of pages that you want the system
to process before printing starts.

Layout Page Orientation The orientation for the trim size in which your job prints.
Select Portrait or Landscape.

Note: When set, it changes the trim orientation in the
Imposition tab, in the Size area.

Scaling The following options are available:

● Manual: Increases or decreases the image size
according to the percentage that you enter.

❐ Do not affect imposition marks: When you select
this option the page is scaled but the imposition
marks stay in the same location.

● Fit to output sheet size: Fits the image to the selected
paper size.

Note: You can also use the Fit to output sheet size
option to scale the layout for imposed jobs.
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Rotate 180 Rotates your job by 180°.

Color Set The following options are available:

● Photos of people: Recommended for jobs such as
family photo albums.

● Outdoor photos:Recommended for jobs that include
mainly photos of landscapes.

● Corporate documents: Recommended for jobs that are
mostly office documents, such as presentation files, web
pages, and files with charts and logos.

● Commercial materials: Recommended for jobs that
include both graphics and photos, such as advertising.

Note: Click the ? button next to the color sets list for more
information.
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Imposition tab in the Job Parameters window
Set and apply imposition settings to your job.

Parameter Option Description

Imposition Method Method ● None: The default option. Imposition parameters are not
available and the thumbnail viewer does not display an
image.

● Step & Repeat: Prints multiple copies of the same
image so it fills up a larger sheet. This method is used
mainly for printing business cards.

Note: The number of copies defined according to pages
or sheets

● Step & Continue: Prints different pages of a job on one
sheet according to the selected layout, so that the sheet
is filled to capacity.

● Cut & Stack:Prints, cuts, stacks, and bounds step &
repeat jobs in the most efficient manner, while
preserving the original sorting. A job's pages, booklets,
or books are sorted in a Z-shape. In other words, each
stack of pages is sorted in consecutive order. When
stacks are piled one on top of another, the entire job is
already sorted up or down.

● Saddle Stitch: A book-finishing technique where the
pages of a book are attached through stitching or
stapling in the spine fold—for example, brochures.
When using the saddle-stitch imposition method, you
can select Sets per sheet. This option enables you to
select how many sets of the job to print on one press
sheet.

● Perfect Bound: A book-finishing technique where the
pages of a book are attached through trimming of the
spine fold, roughening the edges of the gathered pages,
and gluing them together—for example, hardcover books.

Preview Enables you to view your imposition layout and settings.
You can open the Preview window at any time and keep it
open to check your imposition settings as you select them.
The Preview window dynamically reflects any changes that
you make.

Size

Trim orientation
Note: This option is view only.

The orientation, portrait or landscape, for the trim size that
you selected.
If the wrong orientation is selected, an unsuitable template
might be selected and the job might be cropped as a result.
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Preview Enables you to view your imposition layout and settings.
You can open the Preview window at any time and keep it
open to check your imposition settings as you select them.
The Preview window dynamically reflects any changes that
you make.

Templates Layout ● Best Fit: Automatically calculates the most suitable
number of columns and rows.

● Custom: For custom layouts, you need to specify how
many pages to place horizontally (Rows) and vertically
(Columns).

Note: Templates that are created or imported using
Imposition Template Builder, are also available.

Print method Lists the options for how the document will be printed.

● Simplex
● Duplex HTH
● Duplex HTT

Binding selection This option is only available if the imposition method is
either Saddle stitch or Perfect bound, and the template is
2x1, 2x2, 4x2, or 4x4.

North south Use this option when a step and repeat 2x1 or 1x2 template
is selected. The pages will be placed 180 degrees from
each other, on the same side of the imposed sheet.

Rotate 90 deg This rotation can help correct imposition conflicts.

Spacing & Marks Use Spacing & Marks window as a visual reference for the
parameters by clicking the question mark icon (?).
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Marks ● None: Does not apply any marks on the imposition
layout for the printed job.

● Crop marks: Prints the lines that indicate where the
sheet should be cropped. The Both Sides check box
prints crop marks on both sides of the page.

Notes:

❐ You can scale only an image, or the entire sheet
proportionally.

❐ If you want to use crop marks incorporated in the
DTP application, make sure that enough space is left
around your page in the PostScript file so that the
page prints with crop marks.

❐ If your job already includes crop marks incorporated
in the DTP application, you do not need to add crop
marks here. If you do add crop marks, both sets of
crop marks can be printed.

● Fold marks: Prints the lines that indicate where the
sheet should be folded. This is only available with
Saddle stitch or Perfect bound.

● Crop & fold marks: Prints the lines that indicate where
the sheet should be folded. This is only available with
Saddle stitch or Perfect bound.

Margins The value entered adjusts the spaces between the outside
edges of pages and the edges of the sheet on which they
are printed.

Notes:

● Margin settings should suit finishing equipment and
requirements.

● Confirm binding parameters with your binder when
planning your sheet.

Gutter The value that you enter depends on the paper size and
imposition method that you choose.

The gutter size is the space between pairs of pages
(according to the trim size) on a sheet. When the pages are
folded into a booklet, the gutter allows space for trimming.

Spine The value that you enter depends on the paper size and
imposition method that you choose. This is only available
with Perfect bound.
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Bleed The value that you enter depends on the paper size and
imposition method that you choose. You can select
between Maximum bleed or enter a Custom bleed size.

Bleed:

● Extends part or all of the printed image beyond the
trimming boundary

● Ensures that an inaccurate trim setting will not leave an
undesired white space at the edge of the page

● Produces sharp page boundaries with color that extends
all the way to the edge of the page

Notes:

● You cannot extend the bleed size beyond the sheet fold
lines. Bleed does not affect the position of crop.

● Bleed must be defined in your DTP application in order
for the CX print server to be able to apply bleed options.

Creep Creep in ● Auto:Automatically sets a value based on paper weight
● Custom: A custom value

Note: This is only available with Saddle stitch

Creep out The value that you enter depends on the paper size and
imposition method that you choose.

See also:
Imposition overview on page 73
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Quality tab in the Job Parameters window
Apply settings to your job to improve the quality of image and text
elements in your job.

Parameter Option Description

Image/Graphics
Quality

Image quality ● High: Improves the quality of low resolution images in a
job.

● Normal: Processes the image in the job according to
the standard resolution of the press.

The High option improves the quality of images in a job.

Image quality refers to the ability to maintain the same
detail and smoothness with different degrees of
enlargement. This feature is especially useful when your
PostScript file includes several images with different
qualities—for example, images that were scanned at
different resolutions, were rotated, or downloaded from
the Internet.

Graphics quality
(Text, Line)

● High: Improves the quality of text and lines in a job.
● Normal: Processes the text and lines in the job

according to the standard resolution of the press.

Note: It is recommended that you use this option only if
your source file includes diagonal lines or text with
jagged edges.

The Graphics quality (Text, Line) option refers to the
Creo anti-aliasing algorithm for text quality. This option
causes blends to appear smooth with no banding, and
displays crisp diagonal lines without (or with minimal)
jagged (rough) edge, that are the result of the limited
resolution of the print engine.

Improve Text/Line in
Image

Significantly improves the text and line quality in your job. In
some cases, images in the PDL file contain data that
belong to the LW layer, such as screen captures and hi-res
rasterized text. The CX print server is able to identify such
images and convert them into the line work layer.

Smooth Gradients Select to smooth and blend vignettes of continuous tone
(CT) images.

Gloss mark Xerox printing technology that enables you to print
hologram like images in ordinary prints. This technology
uses a single pass method for printing both a background
image and a gloss mark image on the same paper.

Gloss mark images can be seen as a separate image when
the print is viewed at a slightly different angle.
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Trapping Enable Trapping Applies trapping to your job.

Trapping is a solution that solves misregistration between
color separations in both offset and digital printing. This
occurs no matter the accuracy of the printing device, and
results in white lines around objects on top of a background
(in a knock-out procedure) and also between adjacent colors.

Note: If you don't select this option, it does not affect
trapping incorporated by DTP applications—for example,
Photoshop. FAF should not be used with application-based
trapping. In a PostScript file that already contains trapping
from the originating application, it is not necessary to use
CX print server trapping.

Frame thickness: The desired value for the thickness of
the trapping frame. The thicker the frame, the less chance
that white areas appear between images.

Protect small text: Text that is smaller or equal to 12 pt. is
protected and not framed when the trapping algorithm is
applied. You can use this option for small or complex
images, since thicker frames can decrease quality by hiding
parts of an image.

Overprint Black overprint Ensures that black text prints cleanly within a tint or picture
area. The text appears in a richer, deeper black, with the
underlying CMY values equal to those of the printed
background.

PostScript overprint Uses the overprint information that exists in the PostScript
file. This parameter also determines whether the DTP
application PostScript overprint settings are honored in the
RIP.

Screening Screening converts CT (Continuous Tone) and LW (Line
Work) images into information (halftone dots) that can be
printed. The human eye “smooths out” this information,
which seems visually consistent with the original picture.
Thus, the more lines per inch, the more natural the image
appears. Screening is achieved by printing dots in
numerous shapes or lines in an evenly spaced pattern. The
distance between the screen dots or lines is fixed and
determines the quality of the image. Printers can work with
even amounts of toner and still produce a wide range of
colors when you use screening. The darker the color, the
larger the dot.

In order to print an image on a digital printer or press the
color server needs to digitally approximate the grayscale
values with different distributions of black and white pixels.
This process is commonly referred to as half-toning. Digital
halftoning begins by sampling the original image at the
printer dpi and constructing digital halftone cells.

Dot 150 Applies a low dot-type screen. The screen of each
separation is printed at a different angle.
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Dot 200 Applies a high dot-type screen. The screen of each
separation is printed at a different angle.

Dot 300 Applies a high dot-type screen. The screen of each
separation is printed at a different angle.

Dot 600 Applies a very high dot-type screen. The screen of each
separation is printed at a different angle.

Line 200 Applies a high lpi line-type screen. The screen of each
separation is printed at a different angle.

Stochastic Stochastic screening differs from conventional halftone
screening in that high ink density results in more dots, not
bigger dots. Low ink density produces fewer dots, not
smaller dots. As stochastic screening involves millions of
miniscule dots, many more than are used for conventional
halftone screening.

Color tab in the Job Parameters window
Apply various color settings and options to improve the color
quality of your job.

Parameter Option Description

Color Mode Grayscale Prints the job as black and white using black (K) toner
only. The cyan (C), magenta (M), and yellow (Y)
separations are also printed in black (K) toner, giving a
dense appearance similar to the CMYK grayscale image.

Note: Grayscale images created in RGB applications,
such as Microsoft PowerPoint®, should be specified as
Monochrome or submitted to the system with Grayscale
selected in the PPD file. This selection ensures that
grayscale images are counted as black and white instead
of color in both the CX print server and in the printer billing
meters.

CMYK Prints the job in color using the cyan, magenta, yellow and
black inks . This is the color mode set for printing all jobs.

Color Adjustments Brightness The brightness level for the print job. The range starts from
Lightest, which applies -15%, to Darkest, which applies
+15.

Brightness is generally used to make last-minute
adjustments to the print job after proofing. By changing the
Brightness setting, you can control how light or dark your
output will appear.
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Contrast Contrast is generally used to make last-minute
adjustments to the print job after proofing. By adjusting the
Contrast setting, you can control the difference between
the light tones and the dark tones in your image.

Gradation The following options are available:

● None: The printer applies maximum dry ink coverage.
This is the default setting.

● Cool: Blue tones appear clearer.
● Lively: Increases the color saturation.
● Saturated: Increases the strength (chroma or purity).
● Sharp: Increases the contrast.
● Warm: Sets the hues in the low densities to a bright

reddish color.

The Gradation parameter contains a list of gradation
tables that were created in the CX print server Gradation
Tool window. Each gradation table contains specific
settings for brightness, contrast, and color balance.

When you select your predefined gradation table, your job
is adjusted according to the specific table's settings.

Color Flows

Source

Use source CSA Select when you have images from different sources, such
as digital cameras, Internet, and scanners and you want
the images to have the common RGB color spaces.

Note: If you select the Use source CSA profile option and
the file does not contain an embedded source profile, the
CX print server uses the default source profile,
PhotoRGBv2 for RGB and GRACoL2006_Coated for
CMYK.

CMYK source profile The desired CMYK source profile from the following: ,
Euroscale_Coated, Fogra_Coated, Fogra_WebCoated,
Fogra_Uncoated, GRACoL2006_Coated, ISO_Coated,
JapanColor2001_Coated, SWOP®, ISO_Uncoated,
US_Sheetfed_Coated, ISO_Coated_V2_eci, Toyo-
Ink_Coated, None
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CMYK rendering
intent

Rendering intent enables you to compress out-of-gamut
colors into the color capability of the press you are using.
The desired rendering intent should be selected to
preserve the important aspects of the elements and
applied to RGB and CMYK elements.

All printers, monitors and scanners have a gamut or range
of colors that they can output (or view in the case of a
scanner). If a color needs to be output and is outside the
gamut of the output device, it must be mapped or
approximated to some other color, which exists within the
gamut. Rendering Intent enables you to compress out-of-
gamut colors into the color capability of the press you are
using. You can set any rendering intent value for RGB
elements by selecting the required from the Rendering
intent options list. The default value for RGB is Perceptual
(photographic). The default value for CMYK is Relative
Colorimetric.

There are several methods that can be used when
translating colors from one color space to another. These
methods are called Rendering Intents because they are
optimized for various uses. When working with ICC
profiles, it is important that you select the Rendering Intent
that best preserves the important aspects of the image.
Each rendering method specifies a CRD for color
conversions. You can modify the rendering method to
control the appearance of images, such as prints from
Microsoft Office software or RGB photographs from
Photoshop software.
The following options are available:

● Auto: Automatically applies different rendering intents
to each object type (images, text, and graphics). Use
this option when your file includes different objects on
the same page—for example, a presentation that
includes jpg pictures, text, and Microsoft Excel graphs.
If RGB images and CMYK graphic elements are
included on the same page, the RGB images will use
perceptual rendering intent, while the CMYK graphic
elements will use relative rendering intent.

Note: Preserve pure CMY colors is not affected by
this rendering intent option.

● Relative colorimetric: Some closely related colors in
the input color space can be mapped to the closest
possible color in the output color space. This reduces
the number of colors in the image.

● Absolute colorimetric: Select this method for
representing “signature colors“. Colors that are highly
identified with a commercial product. Colors that fall
inside the output color space are matched very
accurately.

● Saturation: Select this method for artwork and graphs
in presentations. In many cases, this option can be
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used for mixed pages that contain both presentation
graphics and photographs.

Note: Select Saturation to achieve smoothness when
you print RGB vector graphics (non image).

● Perceptual: Select this method when working with
realistic images such as photographs, including scans
and images from stock photography CDs. All or most
colors in the original are changed but the relationship
between them does not change.

Emulate source
paper tint

Emulates the original paper tint if it is included in the profile.

Notes:

● You cannot select Preserve pure CMY colors when
selecting Emulate source paper tint.

● If the job is simplex, only the front side will be printed
using the tint emulation.

● When the check box is selected, Absolute
Colorimetric will be used as the rendering method.

RGB source profile The desired RGB source profile from the following:
AdobeRGB1998, AppleRGB, ColorMatchRGB,
SourceRGB_1.8, SourceRGB_2.1, SourceRGB_2.4,
sRGB, PhotoRGB, PhotoRGB_Outdoors,
PhotoRGB_People

RGB rendering intent The following options are available, refer to the description
under CMYK rendering intent for an explanation on each
option:

● Auto
● Relative colorimetric
● Absolute colorimetric
● Saturation
● Perceptual

Apply CMYK
emulation

To convert RGB elements according to the selected CMYK
emulation method, select the Apply CMYK emulation.
The RGB elements receive the same look as the CMYK
elements, creating a unified appearance.

Destination Profile The following options are available:

● Linked: Uses the destination profile that was linked
using the Media and Color Manager in the Resource
Center.

● SpireDC8002

Spot Color Spot color dictionary To convert RGB elements according to the selected CMYK
emulation method, select the Apply CMYK emulation.
The RGB elements receive the same look as the CMYK
elements, creating a unified appearance. The spot color
dictionaries supported are: HKS, Dic Color Guide,
Pantone, Pantone GOE, and TOYO. Refer to the Spot
Color Editor window for the complete list.

Color tab in the Job Parameters window 113



Parameter Option Description

Original file values Uses the CMYK values from the file.

Destination Profile Uses the destination profile selected under Color > Color
Flow, and applies it to the equivalent spot CMYK values.

Protected Colors
Note: If you protect RGB, gray or CMYK colors, all colors
with that specific combination found in the job will be
protected. For example, a specific color combination used
in a logo may align with a color used in an image in the
job. The spot transformation affects the image color as
well as that of the logo, sometimes to undesired results.

CMYK The following options are available:

● Preserve pure CMY colors: Preserves pure cyan,
magenta, and yellow during transformation.

● Preserve black color: Preserves pure black during
transformation.

● Use protected CMYK values: Retains CMYK colors
as defined.

RGB Use protected RGB values: Retains RGB colors as
defined.

Device Gray Use protect gray values: Retains gray colors as defined.

Calibration Linked Uses the calibration table that was created for the media
type, paper weight, and screening method selected for
your job.

Normal This is a default table and cannot be edited. If a calibration
table has not been created for the media type, weight, and
screening method that you are using, the Normal
calibration table is used when you process and print your
job.

None This is a default option and cannot be edited. Jobs that
have this option selected are processed and printed
without using a calibration table.
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Ink Saving GCR: Conserves toner by replacing the gray component
(CMY) of pixels with black toner.

Selecting Normal gives you a smoother image quality.
Selecting High, gives you a less smooth image quality
(adds black into flesh tones).

The gray component replacement also prevents the
consequences of excessive toner buildup, such as flaking
and cracking , or the "curling" effect that may occur when
printing transparencies.

While the gray component of each color is replaced by
black, there is no change in the color quality of the printed
image.

Print grays using
black toner

Prints RGB gray text, images, and graphics with black
toner only. This makes the blacks richer and darker.

You can select from the following:

● For text
● For text and graphics
● For text, graphics, and images

In addition, you can Apply only when R, G, B values are
the same.

See also:
Printing a spot color variation on page 63

Photo touch-up tab in the Job Parameters window
Parameter Option Description

Exposure and color
cast

Corrects underexposure, overexposure, and minor color-
cast problems in photos.

Image noise Reduces noise (such as granularity caused by high ISO
settings) in a photo.

Shadows and
highlights

Brings out details in the dark and light areas of a photo.

Red-eye Removes the red-eye effect in photos taken with a flash.

JPEG artifacts Removes JPEG artifacts often found in low-quality or highly
compressed JPEG files, particularly in gradient and vignette
areas and around the edges of objects.
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Finishing tab in the Job Parameters window
Apply these settings to specify how to finish your job.

Parameter Option Description

Finishing Module Includes the following options:

● OCT (Offset catch tray): The Offset checkbox is
selected by default. If you don’t want to use an offset
between sets, clear this check box.

Note: If the page size is larger than A3 (standard or
custom), the Offset check box is unavailable.

● EHCS (enhanced high capacity stacker):

❐ Select the relevant tray type (Top Tray or Stack Tray).
❐ If you have a chained EHCS, select the desired tray

from the drop-down list.
❐ If you selected Stack Tray, select the Offset check

box for the following types of jobs:

❐ Collated to offset each copy from the next copy
❐ Uncollated to insert an offset sheet when a new

page number is delivered (when you are printing
more than one copy of each page).

● HCSS (high capacity stacker stapler):

❐ Select the relevant tray type (Top Tray or Stack
Tray).

❐ If you selected the Stack Tray, select one of the
following options:

❐ Offset to use an offset
❐ Stapler to select stapling. If you selected

Stapler, select the desired staple location (Front,
Rear, or Dual).

● DFA (document finishing architecture):

❐ Select the desired Profile from the list, according to
the profile set in the printer you are using.

❐ Select the desired Function, according to the profile
set in the printer you are using.

Print Order Collated Prints a complete copy of the job before the first page of the
next copy is printed.

Face up Delivers the job face up

Face down Delivers the job face down
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Slip Sheets Slip sheets between
copies

Prints slip sheets with your job. If a job is collated, the slip
sheets are printed between sets. If a job is not collated, the
slip sheets are printed between groups.

● Tray: The tray in which the specified media type is loaded.
● Frequency: Type the number of slip sheets you want to

print. The default is set to 1; a slip sheet is printed
between each set.

Image Position Same on both sides Shifts the image on the sheet's second side (face down
image) according to the shift on the sheet's first side (face
up image).

Rear The sheet's edge near the printer rear, where printing stops.

Lead The edge of a sheet at which printing begins.

Tip: Use this option to move duplex page data away from
the spine.

Center Prints your job in the center of the page.

Exceptions tab in the Job Parameters window
Parameter Option Description

Type Here you can define which type of exception to apply to
your document. You can select from the following:

● Page range: Type the range of pages for the exception.
● Front cover or Back cover: Select the Duplex check

box to print the first two (or last row) pages of the job as
the cover page (back cover).

Note: If the imposition type is Saddle Stitch, select
Cover to print both a front and back cover page on a
different media type. Select Middle sheet to print the
internal sheets on a different media type.

● Inserts: Select Before or After and type the page
number that will precede or follow the insert. Then, in
the Quantity box, type the total number of inserts you
want to add.

Paper stock Select the media type for the pages you want to apply the
exception.
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Advanced Options The Advanced Options is available only when you select
Page Range, from the Type list.

Destination profile Select either the same destination selected for this job or
from the list of available destination profiles. You Can also
select per page or range of pages.

Image Position The following options are available:

● Same as job: This options allows you to have the image
position be the same as the rest of the job .

● Same on Both Sides: Shift the image on the second
side of the sheet according to the image shift on the first
side of the sheet .

● You can also manually define the shift for odd and even
pages. In addition you can set the pages to center on
the paper.

Services tab in the Job Parameters window
Enables you to set job parameters that will assist your job
workflow on this tab, you can set deletion policies for completed
and failed jobs perform a preflight check on key components, set
font substitution preference, and apply the automatic picture
replacement (APR) mechanism. On this tab, you can set a job
flow, add information to your Job Info items and split a PostScript
file into booklets to simulate a VI job structure. In this tab, you can
also activate a special workflow that decreases significantly the
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processing time for PDF and PostScript files with repeated
elements.

Parameter Option Description

Admin page Print admin page The administration page contains job-related information
such as the job title, page size, number of pages or sets,
and the sender name.

The administration page is printed in the same order as the
job, for face-down printing, the page is printed before each
set and for face-up printing, the page is printed after each set.

Notes: If you change the options in the Admin page
parameter, the job needs to be re-RIPed.

Job Flow Defines the flow the job associated with this job ticket
follows when submitted to the CX print server.

Print RIPs, prints, and stores the PDL files to the Storage area as
RTP jobs(unless the Job Deletion parameter is set to
Delete printed jobs from storage).

Process RIPs and moves the PDL files to the Storage area as RTP
jobs.

Store Places the PDL files directly into the Storage area without
processing them.

Job Deletion Delete printed jobs
from storage

Removes pages or jobs from the CX print server after
printing is completed.

Delete failed jobs
from storage

Removes failed jobs while processing or printing from the
CX print server.

Notes:

● The Delete failed jobs from storage option sustains
enough free disk space for the duration of the print run
and only affects the sub-job.

● The Variable Print Specification file is also deleted.

Font Substitution Use Font
Substitution

Substitutes a missing font with the default font that is set in
the Resource Center.

Notes:

● If a font is substituted, a message appears in the Job
History window.

● You can only substitute Latin fonts.

Optimizations PostScript
optimization

Significantly decreases processing time in PostScript jobs
with repeated elements by applying the PS workflow.

PDF optimization Significantly decreases processing time in PDF jobs with
repeated elements by applying the PDF workflow.
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Parameter Option Description

Preflight Run preflight Checks the status of key job components before the job is
sent for processing. You can select from the following options:

● Fonts
● High resolution
● Spot colors

Your job is RIPed and the missing components are identified.

Split to Booklet Split to Booklets Splits a PostScript, PDF, or large VI job that does not have
a booklet structure into booklets.

Note: Unexpected results might occur when you use this
option for VDP jobs that already have a booklet structure.

Number of pages
per booklet

The desired number of booklets.

Note: If the specified number of pages per booklet is not
sufficient to produce complete booklets and there is a
remainder of pages, the last pages will form a booklet that
contains less pages than specified.

APR/OPI High resolution
images

Replaces low-resolution images in your job with high-
resolution images that are located in a specified APR or
OPI path.

Low resolution
images

Prints the job with the existing low-resolution images—for
example, for proofing purposes.

APR path There are two default paths in which the searching for high-
resolution images:

● Search the input folder: The first searces for high-
resolution images in the same folder as the PDF file.

● D:\Shared\High Res: You can save your high-resolution
files in this folder and the search this folder during the
RIP for the high-resolution files.

Click the (+) button to define a new path for your high-
resolution files.

Job Slug Prints a slug in the margins of your job with the selected
options.

Color bar Prints a measurable color bar. Looking at this bar, you can
tell the state of the the printer and whether the quality is
consistent. You might need to perform calibration or color
proofing.

Job name The Job name is printed in the margin of the sheets within a
job.

Sheet number and
side (front/back)

The sheet number and side is printed in the margin of the
sheets within a job.

Date and time The date and time is printed in the margin of the sheets
within a job.
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Parameter Option Description

ISO conformance
level

The ISO conformance level is printed in the margin of the
sheets within a job. For example: Validation Print according
to ISO 12647-7.

Printer description The name and model of the printer is printed in the margin
of the sheets within a job.

Color server
description

The name and model of the color server is printed in the
margin of the sheets within a job.

Colorant and media The paper stock, paper size and media type is printed in the
margin of the sheets within a job. In addition, the color
mode is also printed.

Color profiles The profiles selected in the job parameters window is
printed in the margin of the sheets within a job.

Calibration date The last calibration date is printed in the margin of the
sheets within a job. For Example: Last Calibration Date: 26
Nov 2008, 15:21

Comment Adds comments containing up to 30 characters.

Job Info Job title Original name of the file related to this job.

Sender User name of the system from which this job originated.

Account Account number of a specific customer or group.

Recipient Name of customer.

Job comments Any special instructions that you want to include with your
job.

Job link Displays the relevant URL for the linked elements of JDF jobs.
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11 Setting up your color
server

The Preferences window
This window contains several tools that enable you to manage your
system and resources. Most of these settings are configured
during the First Time Setup. You should consult with the site
administrator before changing any of the server and network
settings. To access the Preferences window, from the File menu,
select Preferences.

Option Description

Server Setup Displays the computer (host name) name of the CX print
server and current date and time. The CX print server is
configured at the factory with a default generic computer
and host name. Click Change if you want to adjust these
settings.

Network Setup Displays the available network settings. Click Change if you
want to adjust these settings.

Remote Tools Setup The Remote Tools Setup parameter enables you to connect
from your computer to the CX print server over the network
using the Remote Site Manager.

Security Change user passwords and access levels for the
accessing the CX print server. You can change both the
Administrator and Operator password. By default the
system is set to log automatically.

Note: This does not change how you log into Windows.

If you don't want guest users to access the CX print server
select the Disable guest connection check box

Disk wipe

The Disk Wipe utility enables you to work in a more secure
environment, by permanently removing data left by files that
you have deleted. The utility eliminates the contents of your
deleted files by scanning all of the empty sectors on both
the system and image disks, and replacing them with zeros.
Non-empty sectors are left untouched. The Disk Wipe utility
starts automatically every time you quit the CX print server
software.

Note: Make sure that Symantec Norton Utilities™ is not
installed on the system as the Disk Wipe utility does not
function properly with this software.



Option Description

Image Disks Enables you to adjust the image disk threshold in order to
set the minimum free disk space required to process files.

Configuration Backup You can backup and restore your system configuration to a
local hard drive, network drive or to CD or DVD media.

Calibration and Color ● Calibration Device: Select either the Inline
spectrophotometer or the EyeOne. .

Localization Displays local settings on your system, includes, region, unit
measurements, and user interface language. To change one
of these settings, select an option from the drop down menus.

Note: After selecting the language of your choice the
message appears:
You must shutdown and restart your computer before the new 
settings take affect

You need to exit from the workspace and restart your
computer.

Deletion Policy Displays the amount of days and/or hours when to delete
jobs from the system. You can also set the system to delete
jobs automatically from the Storage area. The default
setting holds the jobs in the Storage area until the user
manually deletes them.

Held jobs: Enables you to set the amount of hours when to
delete jobs held in the queue area. By default this is disabled.

Pre-RIP Preview ● PostScript Preview: Specify the desired action when
you close the Adobe Acrobat preview window. Select
either to Save file as PDF or Return to the original PS
file.

● VDP jobs preview: Select the desired number of
booklets that you want to preview before the job is

processed.
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Option Description

Queue Manager In the Job batching policy area, select one of the following:

● Enable job batching to print jobs that have similar
attributes one after the other without the printer pausing
in between.

● Disable job batching to discontinue printing jobs that
have similar attributes and enable the printer to pause in
between printing jobs.

In the Held jobs policy area, select one of the following:

● Bypass held jobs: to bypass held jobs in the Print Queue

Note: This option moves the next job to the top of the Print
Queue and saves valuable production time.

● Don't bypass held jobs: to stop printing from the Print
Queue when a job is assigned a held status.

Note: This option preserves the original order of the files in
the queue.

● Parallel RIP: This option enables you to process two
files simultaneously. When you import multiple PDL files
to the Process queue, you will notice that different jobs
processing at the same time.
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Option Description

JDF/JMF The CX print server receives the JDF job ticket via hot
folders, returns JDF output with job accounting information,
and submits JMF (Job Messaging Format) signals with the
job's status.

If the JDF job has a target path specified in the job, JDF
output is always created. For JDF jobs that do not have a
specified target path, the JDF output is only created if this
option is selected.

Note: In the HTTP URL box, type the file URL or HTTP
URL . This enables you to submit JMF signals with the job
status each time the job status of every job in the system
changes.

General Defaults Here you can configure the general defaults of the system.
Select from the following options:

● In the Default Image Size area, select the default page
size that will be used when the system is unable to
determine the page size of the imported job.

● Select the desired OPI setting to specify how an external
high-resolution image is placed in a PostScript file as it
goes to RIP. If you select Enable OPI Support, the
Support Helios Server check box is automatically
selected. If you do not want Helios server support, clear
this check box.

● Select the Default archive path that is displayed when
you archive jobs.

● Custom Paper Function: select the check box to
enable custom profiles for paper sets.

● In the Job Title Recognition area, select one of the
following options:

❐ Use PostScript Internal name: select this option to
use the internal file name as written inside the
PostScript fileby the print driver.

❐ Use files name (Use when Printing via LPR):
select this option to use the job’s given file name.
Selecting this option ensures that the job appears in
the queue with the name last given by the user.

● Cache global VDP elements: In order to manage your
VDP elements, you need to make sure that you select to
cache your global VDP elements. Select Always cache
global VDP elements check box.

● Stacker palette offset between jobs: Select this option
to offset each copy of a job to the stacker finisher.

See also:
Password protect jobs on page 24
Secure printing overview on page 38
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Setting up a virtual printer

Virtual printers
The CX print server provides three default virtual printers (network
printers).

Virtual printers are used for automating workflows, which then
define job streaming. They contain preset workflows that are
automatically applied to all print jobs processed with that virtual
printer. There is no need to reset job settings for each job, thus
increasing printing efficiency.

The three default virtual printers are:

● SpoolStore: Files are spooled directly to the Storage area and
await operator processing. You can only import PDL files such
as: PostScript, PDF, VPS) to this virtual printer, not RIPed -
processed files.

● ProcessPrint: Files sent to this virtual printer are processed and
printed directly to the Xerox DocuColor 7002/8002 Digital Press
via the CX print server.

● ProcessStore: Files sent to this virtual printer are automatically
processed. After processing, the files are stored in the Storage
area of the CX print server until the print operator re-submits
them for printing.

In addition to using the default virtual printers, you can also create
a virtual printer, or edit a virtual printer's settings.

Adding and editing a virtual printer
This procedure describes how to add a new virtual printer and
then edit job parameters of the virtual printer.

When you add a new virtual printer, you can specify if it is
published on the network and if the virtual printer parameters will
override the PPD parameters. If a job that is sent from the client,
or downloaded to a particular virtual printer contains preset
parameters from the PPD, these options overwrite the parameters
set in the virtual printer for that job. The Printer Default options
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defined in the PPD file use the default parameters set for that
particular virtual printer.

1. From the Tools menu, select Resource Center.
2. In the Resource list, make sure that Virtual Printers is selected.
3. Click Add (+).
4. In the Name box, type a name for the new printer that you

want to add.
5. From the Based on list, select an existing printer with similar

settings.
6. The Publish on the network check box is selected by default.

Clear the check box if you do not want to publish the printer on
the network.

7. Select the Override PPD parameters check box if you would
like the virtual printer settings to override the parameters set in
the PPD file.

8. In the Comments box, type any comment regarding the virtual
printer parameters (optional).

9. Click Edit to change the job parameters of your new virtual
printer.

Note: If you don't edit the job parameters, the settings of the new virtual
printer are taken from the printer on which it was based.

10. Click OK.

The new printer appears in the virtual printer list.

Removing a virtual printer

The three default virtual printers cannot be deleted.

1. From the Tools menu, select Resource Center.
2. In the Resource list, make sure that Virtual Printers is selected.
3. From the virtual printer list, select the virtual printer that you

want to delete, and then click Remove (-).
4. Click Yes.

Maintaining your settings

Backing up the configuration
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You can back up your configuration to a local hard disk, network
drive, or to CD or DVD media.

Note: It is recommended that you backup your configuration to external
media or to a network drive before reinstalling the operating system and
software.

1. From the File menu, select Preferences.

The Preferences window appears.
2. In the Preferences window, select Configuration Backup.
3. In the Configuration backup area, click Browse.

The Save dialog box appears.
4. Locate the desired folder for backup.
5. Enter the file name.

Note: It is recommended that you use the current date as part of the file name.

6. Click Save.
7. In the Configuration backup area, click Start Backup.

After a few moments, the backup complete message appears.

Note: The last path is saved and displayed to the path box. If the backup
was made to external media, the displayed path will be the default: .

Restoring the configuration
Requirements: 

Make sure that you have previously backed up your configuration.

The configuration file extension is .cnf.
Note: Restore can only be implemented for the same software version.

1. From the File menu, select Preferences.

The Preferences window appears.
2. In the Preferences window, select Configuration Backup.
3. In the Restore configuration area, click Browse.

The Open dialog box appears.
4. Locate the folder in which you backed up the configuration.
5. Select the file, and then click Open.
6. Click Start Restore.
7. Select the categories that you want to restore, and click OK.

All custom tables and sets—for example, new virtual printers— are
added to the system when you restore the configuration.
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Tools for maintaining your system
The CX print server includes a number of tools to help you
maintain your system. Following are some of the tools available:

● Formatting the Image Disk: Formats the image disks and
deletes all the files located in the Storage area.

● Disk wipe: The Disk Wipe utility enables you to work in a more
secure environment, by permanently removing data left by files
that you have deleted.

● Auto update tool: The Auto Update tool enables you to install
software updates. These updates include the latest service
packs, Windows hot fixes, and related patches for your CX print
server.
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12 Working with color
server tools on your
computer

Creo Remote Site Manager

Remote Site Manager overview
The Remote Site Manager enables a site manager to monitor the
status of the CX print server and other Creo color servers
connected to printers on a network. It also enables you to operate
these servers from a remote computer.

The Remote Site Manager software includes the following tools:

● The Remote Workspace tool: Allows the users to open an actual
workspace for a selected server on their client workstation and
import jobs, print jobs, preview jobs, and perform certain
workflows. Several users can connect to the same server
simultaneously from different remote workstations.

● The EZ Connect tool: Allows the users to view updated printer
status information.

Note: You can run the Remote Site Manager on your desktop while you use
other applications on your computer. The Remote Site Manager does not
disrupt server activity.

Activating remote tools
Set up a network connection between the client workstation and
the CX print server.

The Remote Tools Setup parameter enables you to connect from a
client workstation to the CX print server over the network using the
Remote Site Manager.

1. From the File menu, select Preferences.

The Preferences window appears.



2. Select Remote Tools Setup.

3. In the WebViewer setup area, select Enable Webviewer.
4. In the Remote workspace setup, select Enable Remote

Connection.

Tip: In this area, you can view Connection Status and how many clients are
connected.

5. Enter the amount of hours that you want the CX print server to
logoff automatically using the arrows in the Logoff
Automatically after option.

6. Click Remote Connections Viewer to see the list of
connections.

7. Click Save.

Installing the Remote Site Manager in Windows
Requirements: 

The remote connection option on the CX print server must be
activated.

1. On your desktop, click Start > Run.
2. In the Run dialog box, type the exact name of the server where

the EZ Connect utility is located, as follows: \\<server_name>.
3. Click OK.
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4. In the \Utilites\PC Utilities folder on the CX print server,
locate the Remote_Site_Manager.exe file.

5. On your computer, double-click the
Remote_Site_Manager.exe  file.
The Remote Site Manager is installed on your computer. The
Remote Site Manager icon  appears on your taskbar after
the application is started.

6. Click OK.

After the Remote Site Manager is installed on your client
workstation, the Remote Site Manager appears under Start >
Programs > Creo Color Server > Remote Site Manager.

You can now add servers, monitor their status, and obtain
information about the printer.

Adding Creo color servers to the Remote Site Manager
The Remote Site Manager software enables you to set up servers
via the Remote Site Manager Setup window. You can add up to
fifteen Creo color servers.

1. On the taskbar, right-click the Remote Site Manager icon.
2. From the menu that appears, select Setup.

A message appears, notifying you that you need to add a
server before using the EZ Connect tool.

3. Click Ok.
The Remote Site Manager Setup window appears.

4. To add a server, in the Remote Site Manager Setup window,
click Add.

5. In the Hostname/IP box, type the exact name of the server
that you want to add—for example, Server1.

6. In the Display Name box, type a name of your choice for the
server.

7. Click Add.

Your new server appears in the Remote Site Manager Setup
window.
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8. Click Save.
Your new server's name appears in the Remote Site Manager
right-click menu.

Viewing the printer status
Requirements:

Before you can use the EZ Connect tool, you must add a server.

After you have added a server, you can view the print status of the
server's Queue manager in the EZ Connect tool.

1. On the taskbar, right-click the Remote Site Manager icon.
2. In the menu that appears, select EZ Connect.

The EZ Connect window appears.
3. Check the status of the printer that is connected to the

selected server.

Remote Workspace overview
Connect to the CX print server workspace, and print a job.

You can connect remotely to the CX print server workspace only in
servers that support the remote workspace option.

The Remote Workspace tool opens an actual workspace for the
selected server and enables you to import jobs, print jobs, and
perform the following workflows:

● View and manage jobs
● View printer information
● Set job parameters

Note: You can view multiple workspaces of available servers on the network
from one Remote Workspace. This applies only to servers of the same
version and product.

Connecting to the workspace from your computer
Requirements:

Make sure that you have activated the remote connection option
on the CX print server.

1. On the taskbar, right-click the Remote Site Manager icon.
2. In the menu that appears, select one of the servers.

The Remote Workspace window of that server appears.
3. In the Storage area, double-click any job.

The Job Parameters window appears.
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4. Click Submit.
The selected job is printed.

Using the Web Center

Overview of the Web Center
The Web Center is a web page that provides online information
and can be accessed from a Windows or Mac computer. You can
connect to the Web Center with the Internet Explorer 5.0 (or later)
and Apple Safari™ browsers.

The Web center enables you to:

● Download remote client tools and printer drivers
● View related documentation
● Find links to related vendors or products
● Access the Easy VDP File Creator for creating variable data

printing files.

See also:
Easy VDP File Creator tool on page 141
Selecting an Easy VDP File Creator template on page 143
Adding records manually to your variable data job on page 145
Creating and printing the variable data job on page 147

Connecting to the Web Center

Note: To connect to the Web Center from a client workstation, you must first
enable the remote connection in the preferences of the CX print server.

1. On your desktop, double-click Internet Explorer.
2. When the browser starts, in the address field type: http://

<server name>—for example, if the CX print server station
name is colorserver_1, type http://colorserver_1.
The CX print server Web Center appears.
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See also:
Easy VDP File Creator tool on page 141
Selecting an Easy VDP File Creator template on page 143
Adding records manually to your variable data job on page 145
Creating and printing the variable data job on page 147

Office Hot Folder tool
The Office Hot Folder tool enables you to automate the printing of
Microsoft Office files when you work remotely. You can drag
Microsoft Office files to a hot folder and then submit the files for
printing on the Creo color server.

The following Microsoft Office versions are supported:
● Microsoft Office XP
● Microsoft Office 2003
● Microsoft Office 2007

Installing the Office Hot Folder tool
Requirements:

Micrososft Office must be installed on your computer in order to
work with Office Hot Folder tool.
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1. On the CX print server, locate the D:\Utilities\PC Utilities folder.
2. Double-click the Office_HF.exe file.

The Office Hot Folder tool is installed on your computer, the
Office HF icon appears on your taskbar, and the Office Hot
Folder tool appears. All network printers that are currently on
your computer appear in the window.

3. Right-click this icon to perform the following actions:

● Open: Open the Office Hot Folders tool and create and
manage hot folders

● Start: Activate file processing in the tool
● Stop: Deactivate file processing in the tool
● Refresh: Restart the tool
● Exit: Shut down the tool

Creating a hot folder
Requirements:

The Office Hot Folder tool must be open.

1. In the Office Hot Folder tool, in the Printers pane, select the
virtual printer for which you want to create a hot folder.

2. Click Create HF.

You can now print Microsoft Office files through this hot folder.

Using the Office Hot Folder tool to print
Requirements:

One of the following Microsoft file formats must already be
submitted to one of the hot folders setup in the Office Hot Folder
tool:

● .ppt
● .doc
● .xls
● .pub

1. In the Creo Office hot folders window, select the hot folder that
you want to use to submit your file.
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2. Drag the file to the hot folder.

Your file is automatically processed and printed according to the
hot folder workflow.

Creo Color Server Job Ticket software

Creo Color Server Job Ticket overview
The Creo Color Server Job Ticket software enables you to create
a Job Definition Format (JDF) file. This JDF file contains a set of
printing parameters (job ticket) and may also include the path to a
file to be printed using those parameters.

Note: If you assign a file to a job ticket, make sure that the file location is
accessible to the color server.

This software can be installed and used on a Windows or Mac OS
computer.

Because you work on a remote computer, you don't need to be
connected to a color server to create a job ticket. You can assign a
job ticket to any type of file.

With the Creo Color Server Job Ticket software you can:

● Create a job ticket
● Open a job ticket
● Load job parameters from a selected server
● Send a job to print using a job ticket that you created

Language settings
The Creo Color Server Job Ticket software displays the language
of your computer's Windows operating system. To ensure that the
language that the Remote Job Ticket software displays and the
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language of the job parameters window that you work with are the
same, set the language of your computer's operating system to
the same language as the color server that you are creating the
job ticket for.

Installing the Creo Color Server Job Ticket software in Windows
1. From your computer, navigate to the /Utilities/PC Utilities

folder on the color server.
2. Double-click the CreoColorServerJobTicket.exe file.

The Creo Color Server Job Ticket software opens. A shortcut to
the Creo Color Server Job Ticket software appears under Start
Programs  > Color Server  > Remote JT .

Installing the Creo Color Server Job Ticket software in Mac OS
1. From your computer, navigate to the Utilities/Mac Utilities

folder on the color server.
2. Double-click the CreoColorServerJobTicket.zip file.

The unzipped package appears on your desktop.
3. Double-click the Creo Color Server Job Ticket package to

install the software on your computer.

The Creo Color Server Job Ticket software is installed on your
computer.

Creating and managing job tickets

Creating a job ticket in Windows
Requirements:

An understanding of the Creo Color Server Job Ticket window

1. From the Start menu, select Programs  > Creo Color Server
Job Ticket  > Creo Color Server JT  > Creo Color Server
Job Ticket V1_0.

The Creo Color Server JT window opens displaying the Job
Parameters window of the server that is currently selected.

2. Set the required job parameter settings.

Note: The Paper Stock and Gradation tools cannot be opened via the Creo
Color Server Job Ticket.

Installing the Creo Color Server Job Ticket software in Windows 139



3. Click Save.

4. In the Save Template dialog box, type a name for the job
ticket, and click Save.

The job ticket is saved in the path defined in the Preferences
window. The default path is: C:\Documents and Settings\All Users
\Color_Server_Client_Tools\CreoColorServer_JT
\V1_0\CreoColorServer_JT
\CreoColorServer_Server_JT_<servername>_1\servers
\FactoryDevice\JT files.

Loading job parameters from a selected server
Requirements:

You can load job parameters from a server, only after you add that
server to the Creo Color Server Job Ticket list of servers.

1. From the Tools menu, select Use JT Settings From.
2. In the list that appears, click the desired server.

A check mark appears next to the selected server, and the Creo
Color Server Job Ticket software loads the appropriate job
parameters window.

Submitting a job ticket for printing
Requirements:

You can only submit a job ticket to print if the job ticket has an
assigned file.

1. After you set all the job parameters for the job ticket, in the
Creo Color Server Job Ticket software main window, click
Submit.

2. In the Name box, type the name of the job ticket.
3. Click Browse.
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4. In the Browse dialog box, locate the file that you want to print
using the job ticket, and click Open.

Note: The file must be in a location that is accessible to the color server,
otherwise, the file won't be printed.

5. Click Submit.

The file is sent to the color server and is printed according to the
settings defined in the job ticket.

Easy VDP File Creator tool
The Easy VDP File Creator tool is a web-based, template-driven
page composition engine that can be used for creating a typical
variable data job and submit it for printing on the CX print server

The Easy VDP File Creator tool includes many templates for you
to choose from in order to create personalized variable data jobs.

Following are some of the templates available on the CX print
server:

● Announcements for a new baby or home
● Business cards and stationery
● Calendar
● Greeting cards for birthdays and anniversaries
● Invitations

There are three main steps involved in using the Easy VDP File
Creator tool:

1. Select a template.
2. Assign data. Enter the data manually or import an existing

database.
3. Create the job and print it to one of the CX print server

virtual printers.

You can access the Easy VDP File Creator tool through the CX
print server Web Center under Links.
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See also:
Overview of the Web Center on page 135
Connecting to the Web Center on page 135
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Selecting an Easy VDP File Creator template
The first step in creating a variable data job is to select the type of
job and template that will be printed.

1. Open the CX print server Web Center, select Links, and then
select Easy VDP File Creator.

The Easy VDP File Creator tool opens and lists the templates
available.

2. In the Templates area, select the category and subject of the
type of variable data job that you want to create, for example,
Announcements > New baby.
The templates matching this selection appear in the Design
and properties area.

Selecting an Easy VDP File Creator template 143



3. In the Design and properties area, select the template for
your job.

Note: When you select a template the properties appear showing the
variable data fields assigned to that template. Each template has a different
set of fields that are suitable for that job.

4. Click Continue to add data records.

Next:

The next step is to add records to your job.

See also:
Overview of the Web Center on page 135
Connecting to the Web Center on page 135
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Adding records manually to your variable data job
The next step in defining a job using the Easy VDP File Creator
tool is to assign the information that will appear on the printed
variable data job.

In this step you add the variable data directly in the Easy VDP File
Creator tool.

1. In the Easy VDP File Creator tool, select Manually.

2. In the Variable Data area, type in the data for each field. If you
want a particular field to appear on every record then select
the Apply to all records check box next to that field.

Note: Some of the fields may require you to upload images.

3. Click (+) to add the data to the list of records.

Note: To remove a record from the list, click (-) to delete a record.

Next:

The next step is to create the job and submit it for printing.

See also:
Overview of the Web Center on page 135
Connecting to the Web Center on page 135
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Adding records from a database to your variable data job
The next step in defining a job using the Easy VDP File Creator
tool is to assign the information that will appear on the printed
variable data job.

In this step you can upload an Excel file containing the variable
data information that you want to appear on each record.

Note: The Excel file must include the same fields as defined in the properties
of the template that you selected.

1. In the Easy VDP File Creator tool, select Database.

2. Click Browse to upload your Excel database file, or click
Create Database File.

Note: When you select Create Database File, Excel opens with a
worksheet containing the field names in the first row suitable for the
template you selected.
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3. Type in the data for all the records that you want to create.
4. When you are done, save the file and then close Excel.

Next:

The next step is to create the job and submit it for printing.

Creating and printing the variable data job
The final step in creating a variable data job using the Easy VDP
File Creator tool is to create the job and submit it for printing to
one of the CX print server.

1. After you have added all the data in step, click Create Job.

2. Type a name for the variable data job.
3. From the Virtual Printers list, select a virtual printer to submit

the job to.
4. Click Submit.

A message appears that the file was successfully submitted to
the Creo Color Server. You can either close the Easy VDP File
Creator tool, or click Submit another job to start the process
again.

The variable data job you created is submitted for processing and
printing on the CX print server. You can view the status of the job
in the Web Viewer > Queues.
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See also:
Overview of the Web Center on page 135
Connecting to the Web Center on page 135
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13 Troubleshooting

Job History window
The Job History window lists all of the messages that were
generated during the workflow of the selected job. You can view
the job title and owner (the user name of the system from which
the job originated) near the top of the window.

Job Information

Job title The job's file name.

Sender The user that sent the file to print.

Show Click one of the icon types (Information,
Warning, or Error) to view or not view (toggle)
those message types in the Job History
window .

Type There are three types of messages:

●  Information
●  Warning
●  Error

Date & Time The date and time on which the message was
emitted (the time stamp).

Stage The stage in the workflow—for example, Print
Queue or Process Queue.

Message The message text.



Handling alerts and frozen jobs

If your job has failed or is frozen, you can view an alert message
about the failed or frozen job.

1. In the workspace, do one of the following:

● In the Print queue click the frozen icon  that appears next
to the frozen job.

● In the Storage area click the failed icon  that appears next
to the frozen job.

● Select the job with the failed or frozen icon and then click
the Alert button  on the toolbar.

If you clicked the frozen or failed icon, the following message
appears.

If you clicked the Alert button, the Alerts window appears.

2. Close the alerts information.
3. If a job was frozen, follow the directions in the alert message to

correct the situation (incorrect or missing paper stock or finisher).
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Aborting a job
Requirements: 

A job is processing or printing.

Right-click the running job in one of the queues, and select
Abort.

The job moves from the queue to the Storage area. The Aborted
status is assigned to the job, and the next job in the queue starts
running.

Resume printing
Resume printing an aborted job.

Right-click the aborted job in Storage area, and select
Resume printing.
The job continues printing from the last page that was printed.

Alerts window
In the Alerts window you can view system alerts, and alerts for the
selected job.

Alert window options

Show Selected Displays the alert for the selected job in the
queues or Storage area.

Show All Displays systems alerts and the alerts for the
selected job.

Clear Alerts Clears all of the alerts from the window.

Aborting a job 151



Printing system messages
Print a list of system messages from the Message Viewer window.

1. From the Info menu, select Messages Viewer.
2. Filter and sort the message list as desired.

● Click any message type icon —for example, Error—in
order not to list such messages.

● Click a column header to sort the list by that column.
3. Click Print List..

The Print window is displayed.
4. Set the printing options as desired, and click OK.

The data is printed according to the current filtering and sorting.
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14 Glossary

absolute colorimetric
A method of color matching during the translation of files from one
device to another. The absolute colorimetric method refers to the
use of device-independent color space.

amplitude-modulated (AM) screening
A type of halftone screening in which the size of the dots varies but
the spacing between dot centers is constant. For darker areas, the
dots are bigger, and for lighter areas, they are smaller.

Automatic Picture Replacement (APR)
Technology in which two versions of a file are created—a high-
resolution file and a low-resolution file called PSImage. You use the
latter file for positioning and manipulating images in DTP software.
The high-resolution file automatically replaces the low-resolution
version during the RIP process.

backup configuration
A compressed file that contains a copy of system configuration
settings, saved for the purpose of disaster recovery—for example,
in the event of a disk crash.

bitmap file format
A file format in which graphics are represented by a series of
pixels. The file name extension is .bmp.



booklet
In a variable information (VI) job, a personalized copy of a
document. A booklet can consist of several pages, but the entire
document is targeted at a specific individual or address. VI jobs
contain elements that differ from booklet to booklet, including text,
graphics, pictures, and page backgrounds.

bounding box
In a PostScript file, the smallest rectangle that encloses all of the
graphic elements. The bounding box is specified by two sets of
coordinates.

brightness
The amount of light reflected from a surface, regardless of the hue
or saturation of color. In print reproduction, the reflectance of the
paper affects brightness.

Brisque Imposition Job
A job folder that contains an electronic description of the marks,
geometry, and layout of Brisque Page positions for one or more
signatures. It does not contain page content, only pointers to the
Brisque Pages. You can create a Brisque Imposition Job by
preparing an ICF and translating it in Brisque, or you can create it
in the Brisque Preview workspace. You can preview a Brisque
Imposition Job and send it to output along with the pages
positioned in it.

Brisque Job
A folder generated by the RIP operation. The Brisque Job folder
contains one or more Brisque Page folders.
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Brisque Page
A folder generated by the RIP process and residing in the Brisque
Job folder. A Brisque Page contains rasterized page information
that consists of a LW or NLW file. A Page can also include a CT
file and one or more NCT files.

cache
To store data after it has been accessed so that future access will
be faster.

calibration curve
A curve that represents the percentage at which the software
adjusts an original tint during screening to produce the target output.

click charge
A fee that vendors charge for each printed or copied page. Click
charges are part of the maintenance agreement between the
vendor and the customer.

CMYK
A color representation scheme (or color space) in which cyan,
magenta, yellow, and black are combined to create full-color images.

colorant
A pigment, dye, phosphor, or other such substance that produces
a color. Colorants are like building blocks of colors—for example,
green is composed of cyan and yellow, so cyan and yellow can be
considered colorants that make up the color green.
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color cast
The predominance of a particular color that affects the whole
image in the original, proof, or reproduction. A color cast is due to
an excess of a color pigment or light. It is most obvious in gray and
near-gray areas.

color channel
A single color, such as red, green, or blue.

color correction
The process of improving or altering the color components of an
image to compensate for deficiencies in printing inks, to solve
problems in the color separation itself, or to fulfill a customer’s
request for modification.

color gamut
The range of possible colors that can be represented in a given
circumstance, such as within a given color space or by a certain
output device.

color management
A process that aims to control the representation of colors across
a variety of output devices so that the colors that are generated
appear consistent. Color management is based on the
coordination of three processes: device calibration, device
characterization, and conversion from one color space to another.

color mapping
A color-correction method used to convert an input file’s color
space to a target’s color space.
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color match (verb)
To keep colors consistent when converting one color space to
another—for example, RGB to CMYK.

color profile
A description of the range of colors that a device can produce. A
color profile makes it possible to convert the color space of one
device (such as inkjet printer) to another device (such as a
computer monitor).

color rendering dictionary (CRD)
A three-dimensional lookup table for transforming all process color
models.

color set
A collection of separations that you associate with pages in an
edition plan to represent the color separations that are expected to
make up those pages.

color space array (CSA)
A three-dimensional or four-dimensional lookup table that contains
data for translating a device-dependent color space into a device-
independent L*a*b* color space.

composite file
A single file—for example, a composite PostScript file or a PDF file
—that contains all the color information and is not divided into
color separations. That is, the color information is not divided into
cyan, magenta, yellow, black, or spot colors.
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composite mode
A mode of operation in which all the color information associated
with a particular page is described on one page of a PostScript
file. During RIP, the file is separated into process colors and spot
colors, one file for each color. This mode of operation is the fastest
and most efficient in most cases.

contrast
The ratio between the light tones and the dark tones in an image.
If you increase the contrast, highlights become lighter while
shadows become darker.

conventional screening
A method of screening in which a continuous-tone image is broken
down into a series of dots of varying sizes that are placed in a rigid
grid pattern. Color images are separated into the four process
colors, and individual screens of color are created and then
skewed at angles to reproduce the image in print.

creep
The extension of middle pages of a folded signature slightly
beyond outside pages. Shingling compensates for creep.

CT/LW
Relating to a raster page that contains CT files, LW files, or both;
or to a workflow that creates CT and LW files.
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CT file format
A four-color (CMYK) continuous-tone (or contone) raster file
format. Gradient tones and continuous-tone data are sometimes
converted to CT format.

database
A software module that holds site configuration information, edition
plan information, and the current state of each process and
planned item. At least one workstation at each site must have a
database installed.

DCS (desktop color separation)
An EPS format containing five files: four of the files contain the
separated color information for each of the CMYK colors and the
fifth is a low-resolution composite file for use in electronic page
layout. DCS1 format has five separate files. One file acts as the
preview and the other four contain the information for printing the
different channels of CMYK color.

DCS-2
A desktop color separation (DCS) file with additional files that
contain spot color information.

densitometer
An electronic instrument which measures the optical density of film
or reflective media. A transmission densitometer is used to
measure films while a reflection densitometer is used to measure
photographs and ink laydown on press sheets.
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density
A measurement of the ability of light to be absorbed by an ink and
paper combination. A darker tone has a higher density than a
lighter tone.

density range
The range of density from highlight to shadow on a film negative or
positive or on the printed image. It is calculated as the
mathematical difference between the densities of the darkest and
the lightest tone values.

device
An individual occurrence of a physical device that reproduces an
image. Devices have a type and a customer-specified name.
Because the declaration of a device does not include its operating
conditions—such as ink selection, type of screening, and paper—
you cannot measure the color response of a device on its own. (In
ICC terminology, the declaration of a device does include its
operating conditions.)

device-independent color space
A color space based on human perception of color, measured
using a colorimeter or spectrophotometer. The color space is
independent of the color capabilities of any specific device. An
example is CIELAB. A device-independent color space may be
used as an intermediate color space when converting from one
color space to another, for example, from CMYK to RGB.

device link profile
A one-way link or connection between two color imaging devices.
Such a one-way link can be between devices such as a scanner
and a printer, a scanner and a color monitor, or two printers. Using
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device link profiles helps shorten the conversion path in certain
applications and saves computing time.

device profile
A type of ICC profile that represents the relationship between
colorant tint values of a device and the resulting color. It has two
sets of color mapping tables: one set maps device colorant tint
values to the profile color space while the other set maps the
profile color space to device colorant tint values.

device type
A classification of a device into one of several types that implies a
set of capabilities and behavior. The list of device types is fixed.

dot area
The percentage of an area covered by halftone dots, ranging from
no dots at 0 percent to a solid ink density at 100 percent. The size
of a single dot is stated in a percentage of the area it occupies.

dot gain
A printing effect which results in dots being printed larger than they
should be. It occurs as a result of ink spreading on the printed
page, and if not compensated for, can lead to an image appearing
too dark.

element
Any item within a job—including an input file, page, page set,
signature, surface, or separation.
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frequency-modulated (FM) screening
A method of creating halftones where the spots are all the same
size, but the frequency or number of dots changes in a given area.
There are more dots in a dark area and fewer in a light area.

frozen job
A job for which the appropriate paper stock is not available: for
example, the correct paper type, size, or weight.

gravure printing
A printing method in which the image is engraved through a
screen below the surface of a cylinder. The ink is transferred to
paper when pressed to the cylinder. Gravure is used for very long
print runs and on many substrates.

gray balance
The values for yellow, magenta, and cyan that produce a neutral
gray with no dominant hue when printed at a normal density.

gray component
The amounts of CMY in a color which result in neutral gray, based
on the lowest separation value of the color.

gray component replacement (GCR)
A method for reducing the CMY amounts that produce the gray
component in a color, without changing the color hue.
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grayscale
A reflection or transmission film strip showing neutral tones in a
range of graduated steps. This scale is used as a test/check of the
printing conditions, and is often attached to the printed image
above or on the side as a color bar.

halftone screen
On halftone output, the fine grid that positions the halftone dots.

head-to-head
A type of layout in which the tops of the pages are facing in.

Imposition Job

job flow
The job parameter settings of selected virtual printers, which are
automatically applied to all jobs printed using those virtual printers.
These settings determine how a sent or imported file is processed.
For example, a file sent to a virtual printer with a Process & Print
job flow will be RIPed, printed, and stored in the Storage Folder. A
file sent to a Process & Store job flow virtual printer will be RIPed
and stored, without printing.

job ticket
A hidden file that is created when you associate an input file with a
particular template. The job ticket contains all the instructions for
processing the input file.
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job ticket template (JTT)
The name by which a process template is referred to in a Brisque
environment. JTT files have a .jtt extension.

L*a*b*
A device-independent color measurement system that measures
Lightness (or Luminance) and two color coordinates, A (red/green)
and B (blue/yellow). It may be used as an intermediate color space
used when converting from one color space to another (for
example, from CMYK to RGB).

line work
Data characterized by sharply defined lines and very clear
transitions from one color to another—for example, text. Line work
is stored in the computer as a series of geometric (vector) drawing
instructions.

long-edge first (LEF)
A printer page orientation where pages are delivered to the printer
with the long edge of the paper going in first.

lookup table (LUT)
A two or three-dimensional array of values that stores information
about specified input-output relationships. When an input value is
known, the system can automatically determine the correct output
value. For example, the system can find the required dot size for a
given set of printing conditions based on the stored gray level.
Color setups can be saved in color tables (color transformation
tables), which is one of the many kinds of LUTs.
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LW file format
A file format that contains line work data. LW files support CMYK
only (no spot colors) and up to 256 colors.

new line work (NLW) file format

NLW file format
An LW file format that supports spot colors (up to 28 spot
separations plus the four process colors) and up to 65,535
different colors.

normalize
A step in the refining process that creates PDF pages from input
files. The resulting PDF files contain refined pages. Options in the
normalize process are: OPI, image optimization, and font handling.

PDF/X
Abbreviation for Portable Document Format eXchange. An
exchange format for sending pages between a page preparation
site and a printing site. PDF/X is a subset of the full PDF
specification.

PPD (PostScript Printer Description)
A file specification set by Adobe Systems, Inc. It contains output-
device-specific information, including fonts, line screens, offset
margins, supported page sizes, and so on.
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pre-separated file
A PDF, PostScript, or TIFF file that contains a separate page for
each color in a document. A standard process color job would
have four pages—one for each process color. A job with spot
colors would have a page for each spot color and a page for each
process color.

printer description file
A PPD file or PDF file that Apple Macintosh® software uses to
prepare pages and documents for specific output devices.

priority
The level of urgency assigned to a page that controls the order in
which Kodak NewsManager™ processes pages, if more than one
page is ready for processing at the same time. NewsManager
processes the higher priority items before the lower priority items.

process
An action initiated on a file—for example, refining a PostScript file,
copying a file from one folder to another, or outputting a TIFF file
to plate.

process colors
The four ink colors that are used to reproduce full-color images:
cyan, magenta, yellow, and black (CMYK). Combinations of CMYK
are used to reproduce many colors of the spectrum.

PSImage
A low-resolution EPS file that is part of the Automatic Picture
Replacement (APR) workflow. You use PSImage files to position

166 Chapter 14—Glossary



images in page layout. You can create and edit a PSImage file in
various applications, such as PSImage Exporter in Photoshop,
Copydot Toolkit, and oXYgen software. If you edit a PSImage file
(for example, you add a mask or a clipping path), the workflow
software applies your changes to the high-resolution file and
automatically replaces the PSImage file during the RIP process.

relative colorimetric
A method of color matching. When translating colors from one
device to another, it retains the colors that fall within the range of
both devices.

render
To determine the output resolution and how Kodak Prinergy® will
handle spot colors.

RGB
Abbreviation for the additive primaries—red, green, and blue.
These colors are the predominant colors in the visible light
spectrum that the human eye can detect. The RGB colors are
used, for example, in video monitors, scanners, and other devices
in which the light is direct and not reflected.

rich black
A black area to which layers of other inks, referred to as support
screens or booster colors, have been added to make the color as
dark as possible.

RTP (ready-to-print) job
A job that has been RIPed and is in the appropriate format for
printing. You can submit RTP jobs for reprinting without
reprocessing them.
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screen angle
The angle at which a halftone screen is set for printing halftones.
Proper screen angles minimize moiré patterns.

shadows
The darkest part of an image (original and reproduction). A
shadow has densities near the maximum. In a reproduction,
shadows are printed with dot areas between 80 percent and 100
percent.

sheet
Both surfaces of one printed press sheet.

short-edge first (SEF)
A printer page orientation where pages are delivered to the printer
with the narrow edge of the paper going in first.

slug
The text added to one side of the printed layout. The slug contains
information about the job and its settings. Also referred to as label
or caption.

SMB (Server Message Block)
SMB, also known as CIFS (Common Internet File System), is a
protocol for sharing files, printers, and other resources between
computers.
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smooth scaling
The ability to maintain the same detail and smoothness with
different degrees of enlargement. Smooth scaling allows you to
scale up low-resolution images without creating a jagged
appearance.

source profile
The specifications for how the CMYK and RGB values in a file
should be interpreted as an actual color when displayed or output
through a given device.

spine trim size
The space between adjacent pages on a printed sheet.

spot color
A special ink color, not included in the process color set, that is
used to specify the color of a graphic design element.

spot color library
A collection of spot colors for which spotless color recipes are
sought. A spot color library contains one or more spot colors. Each
spot color includes a name and a CIELAB color space.

step and repeat
The procedure of copying the same image by stepping it in
position both horizontally and vertically according to a
predetermined layout.

169



stochastic screening
A digital screening process that converts images into very small
dots of equal size and variable spacing. Also referred to as
frequency-modulated (FM) screening.

substrate
Any printing surface to which ink will adhere. Also referred to as
stock.

TIFF
Acronym for Tagged Image File Format. TIFF is a file format used
to describe, store, and exchange bitmap images. TIFF is cross-
platform, highly flexible, and capable of saving a wide variety of
image types, including photographs and illustrations. Most page
makeup and image editing software supports TIFF.

TIFF/IT-P1
Acronym for Tagged Image File Format for Image Technology,
Profile 1. A file format that is similar to TIFF/IT, but provides a
minimized set of options that allows simpler implementation when
the full set of TIFF/IT options is not required.

tint
The percentage value assigned to a dot.

tonal calibration
The act of setting equipment to reproduce tonal values to specified
values on final output such as a proof, press sheet, or plate.
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trapping
A printing technique in which adjacent printed colors are slightly
overlapped to ensure that white space does not appear between
the colors.

variable information (VI) job
A job in which printed materials such as bills, targeted advertising,
and direct mailings are individualized for specific recipients or
purposes.

variable print specification
Formal language designed for effective production of variable
information documents.

vector drawing
The geometric system used to define lines and curves in computer
graphics. It is most often used for line drawings.

virtual printer
A printer that contains preset workflows that are automatically
applied to all print jobs processed with that virtual printer.
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